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การออกแบบและสร้างเวบ็เพจ็มลัตมีเดียแอนนเมชัน่ เบือ้งต้นิ ิ  
จาํนวนชัว่โมง 30 ชัว่โมง 
วตัถปุระสงค ์
1. สามารถปรบัแต่งภาพโดยใชเ้ครือ่งมอืต่างๆ ของ Adobe Photoshop  CS2 ได ้
2. สามารถนําเอารปูภาพทีป่รบัแต่งไปใชง้านกบัเวบ็และงานต่างๆ ได ้
3. สามารถนําผลงานทีไ่ดไ้ปประกอบเป็นเวบ็ไซต ์

โดยใชโ้ปรแกรม Macromedia Dream weaver เบือ้งตน้ ได ้
4. สามารถใช ้Action Script เพือ่ควบคุมการทาํงานต่างๆ เบือ้งตน้ไดเ้อง 

การจดัเตรียมโปรแกรมกอนการอบรม่  
1. ระบบปฏบิตักิาร Windows XP/2000/ME/98 
2. โปรแกรม Photoshop CS2, CS3 
3. โปรแกรม Adobe Dreamweaver CS3 

กลมุเป้าหมาย่  
 ขา้ราชการในหน่วยงานภาครฐั นักศกึษาและประชาชนทัว่ไป ทีม่พีืน้ฐานการออกแบบเวบ็ไซตม์า
อยา่งด ีแลว้ 

จาํนวน 30 คนตอรนุ่ ่  
ประโยชน์ท่ีได้รบั 

ผูเ้ขา้รบัการอบรมสามารถนําความรู ้ความสามารถทีไ่ดร้บัจากการอบรมไปประยุกตใ์ชใ้นการ
ทาํงานและการดาํเนินชวีติประจาํวนัไดอ้ยา่งมปีระสทิธภิาพ 

คณุสมบตัผูเ้ข้าอบรมิ  
1. ตอ้งเคยการออกแบบเวบ็ไซตม์าก่อน 
 
หวัข้อการอบรม 

หลกัสตูรสาํหรบัผูท้ีส่ามารถสรา้ง Web และ Presentation ในรปูแบบของภาพเคลือ่นไหว 
(Animation) สามารถใสเ่สยีงประกอบและสรา้ง Effect ใหก้บั Animation เชน่ การ Menu หรอื ทาํ
ปมุ ทีส่ามารถเคลือ่นไหวได ้และมเีสยีงประกอบเป็นการสรา้งงาน่  Animation หรอืภาพเคลือ่นไหว
ดว้ยเทคนิคต่างๆ เชน่ การซอ้น Layer การทาํ Masking Layer หรอื การทาํ Twinning แต่ละแบบ 
เพือ่สรา้งใหก้บัภาพเคลือ่นไหว มกีารทาํ Interactive และ Action script เพือ่การทาํ Web 
,Presentation โดยจะมกีารคาํสัง่ Action script ระดบัเบือ้งตน้ การสรา้ง Web Interface แบบที่
เป็นการเคลือ่นไหว  
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ตอนท่ี 1 การสร้างเวบ็เพจด้วยภาษา HTML 0

 

ภาษา HTML 

 

Client Server

W W W

- HTML
- Style Sheet
- JavaScript
- VB Script
- Java Applet

- PHP
- ASP
- JSP
- PERL
- CGI  

รปูท่ี 1 การตดิต่อสือ่สารผา่น เวลิดไ์วดเ์วบ็ 

 
ภาษา HTML (HyperText Markup Language) เป็นภาษาหลกัทีใ่ชใ้นการสรา้งเวบเพจ (Web Page) 

เป็นภาษาประเภท Markup Language เกดิขึน้จากการพฒันาระบบ World Wide Web ในเดอืนมนีาคม 1989 
โดยนกัวจิยัจากสถาบนั CERN (Conseil European Pour La Recherche Nucleaire) ซึง่เป็นหอ้งทดลองในเมอืง
เจนีวา ประเทศสวสิเซอรแ์ลนด ์ ชื่อ ทมิ เบอรเ์นอร ์- ล ี (Tim Berners - Lee) ซึ่ง ทมิ เบอรเ์นอร ์- ล ีไดนํ้า
แนวความคดิในเรื่อง Hypertext ของ Vannevar Bush และ Ted Nelson มาใชเ้พือ่กระจายขอ้มลูในองค ์ต่อมามี
การพฒันาและกาํหนดมาตรฐานโดยองคก์รทีช่ือ่วา่ W3C (World Wide Web Consortium) 

ภาษา HTML เป็นภาษาทีม่ลีกัษณะของขอ้มลูทีเ่ป็นตวัอกัษรในมาตรฐานของรหสัแอสก ี(ASCII Code) 
โดยเขยีนอยูใ่นรปูของเอกสารขอ้ความ (Text Document) จงึกําหนดรปูแบบและโครงสรา้งไดง้า่ย ภาษา HTML 
ไดถู้กพฒันาขึน้อยา่งต่อเน่ืองตัง้แต่ HTML Level 1 (รุ่นดัง้เดมิ), HTML 2.0, HTML 3.0, HTML 3.2 และ HTML 
4.0 ซึง่เป็นรุ่นทีนิ่ยมเขยีนกนัในปจจุบนัั  (ขณะน้ี W3C ไดพ้ฒันา HTML 4.01 ออกมาแลว้ เพือ่ลองรบัมาตรฐาน
ภาษา XML) จงึทาํใหภ้าษา HTML ในปจจุบนัสามั ารถแสดงภาพทางกราฟฟิกและระบบเสยีงได ้เพือ่ตอบสนอง
ในการทาํงานในปจจุบนัั  

ภาษา HTML สามารถสรา้งขึน้ไดจ้ากโปรแกรมสรา้งไฟลข์อ้ความ (Text Editor) ทัว่ ๆ ไป เช่น 
Notepad หรอื Word Processing ได ้อกีทัง้งา่ยต่อการเรยีนรูเ้พราะภาษา HTML ไมม่โีครงสรา้งความเป็น 
Programming เลยแมแ้ต่น้อย และไฟลท์ีไ่ดจ้ากการสรา้งเอกสาร HTML ยงัมขีนาดเลก็อกีดว้ย 

นามสกุลของไฟล ์ HTML จะเป็นไฟลน์ามสกุล .htm หรอื .html ซึง่ใชใ้นทัง้ระบบปฏบิตักิารยนิูกซ ์
(UNIX) และระบบปฏบิตักิาร Windows และเรยีกใชง้านไดจ้ากเวบ็บราวเซอร ์(Web Browser) 
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รปูท่ี 2 ตวัอยา่งการเขยีนภาษา HTML ดว้ยโปรแกรม Notepad 

 

 
รปูท่ี 3 ตวัอยา่งการเปิดดเูอกสาร HTML ดว้ยโปรแกรม Internet Explorer 

 

โครงสร้างภาษา HTML 

คาํสัง่ในภาษา HTML เรยีกวา่ แทก็ (Tag) จะเขยีนอยูใ่นเครื่องหมาย < และ > แทก็จะแบ่งไดเ้ป็นสอง
กลุม่ คอื แทก็แบบเปิด และแทก็แบบปิด โดยปกตแิลว้แทก็ของภาษา HTML จะเปิดและปิด โดยมรีปูแบบดงัน้ี 

รปูแบบ  <TAG> .... </TAG>  
เชน่   <HTML> .... </HTML>, <B> .... </B> 

การปิดแทก็จะใชเ้ครือ่งหมาย / (Slash) เป็นตวักาํหนดในแทก็ทีปิ่ด สว่นแทก็อกีประเภทหน่ึงจะเป็นแทก็
ในลกัษณะเปิด คอื ไมต่อ้งมแีทก็เปิดทา้ย เชน่ <IMG>, <BR>, <WBR> เป็นตน้ 
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เพือ่ความเขา้ใจงา่ยในการกาํหนดโครสรา้งภาษา HTML เราจงึควรกําหนดแทก็เปิดและเปิดใหเ้หมาะสม
เพือ่สรา้งความสมดุล เช่น เมือ่เราตอ้งการใชก้ําหนดใหต้วัอกัษรเป็นตวัหนาโดยใชแ้ทก็ <B> และใหม้กีารขดีเสน้
ใตโ้ดยใชแ้ทก็ <U> เราควรทีจ่ะกําหนดการเปิดและปิดแทก็โดยเมือ่ขึน้ตน้ดว้ยแทก็ <B> และตามดว้ยแทก็ <U> 
ควรจะปิดดว้ยแทก็ </U> ก่อน แลว้ตามดว้ยแทก็ </B> ดงัน้ี 

  <B><U> .... </U></B> 

 
โครงสร้างหลกั 
รปูแบบมาตรฐานในการสรา้งเวบเพจประกอบดว้ยคาํสัง่หลกัอยู ่4 คาํสัง่ ดงัน้ี 
<HTML> .... </HTML> เป็นคาํสัง่ทีท่าํหน้าทีบ่อกจุดเริม่ตน้และจุดสิน้สดุของเวบ็เพจ  
<HEAD> .... </HEAD> เป็นคาํสัง่ในสว่นของการกําหนดสว่นหวัเรื่องของเวบ็เพจ โดยในคาํสัง่ HEAD 

จะมคีาํสัง่ <TITLE> .... </TITLE> อยูด่ว้ย ซึง่ทาํหน้าทีก่าํหนดขอ้ความทีแ่สดงบน Title Bar โดยสามารถกาํหนด
ความยาวของขอ้ความได ้64 ตวัอกัษร  

<BODY> .... </BODY> เป็นคาํสัง่ในสว่นเน้ือหาของเวบ็เพจทัง้หมด  
รปูแบบการเขยีนมดีงัต่อไป 

<HTML> 
<HEAD> 
 <TITLE> Title Bar </TITLE> 
</HEAD> 
<BODY> 
 . 
 . 
 . 
 . 
</BODY>  
</HTML> 

 

การจดัรปูแบบเอกสาร 

คาํสัง่ในการกาํหนดหวัเรื่อง (Headding) 
การกาํหนดหวัเรือ่งเราจะใชค้าํสัง่ Headding <H> เพือ่แสดงอตัราอกัษรขนาดใหญ่กวา่ปกต ิเช่น ชื่อบท, 

ชื่อหวัขอ้ เป็นตน้ คาํสัง่ heading มดีว้ยกนั 6 ระดบั โดยทีร่ะดบั 1 จะมขีนาดใหญ่สุด และระดบั 6 จะมขีนาดเลก็
ทีส่ดุ มรีปูแบบคาํสัง่ดงัน้ี 

<H1> .... </H> 
<H2> .... </H> 
<H3> .... </H> 
<H4> .... </H> 
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<H5> .... </H> 
<H6> .... </H> 

ตวัอยา่งที ่1 head.html 

<HTML> 
<HEAD><TITLE> Heading </TITLE></HEAD> 
<BODY> 
<H1> Heading Levle 1 </H> 
<H2> Heading Levle 2 </H> 
<H3> Heading Levle 3 </H> 
<H4> Heading Levle 4 </H> 
<H5> Heading Levle 5 </H> 
<H6> Heading Levle 6 </H> 
</BODY> 

 
คาํสัง่ขึน้บรรทดัใหม่ (Line Break) 
โดยปกตใินการพมิพเ์อกสารทัว่ ๆ ไป เราจะขึน้บรรทดัใหมโ่ดยใชก้ารกด Enter แต่ในการสรา้งเอกสาร 

HTML เวบ็บราวเซอรจ์ะถอืเป็นการเวน้วรรค 1 ช่อง และใชเ้ป็นจุดตดัคาํขึน้บรรทดัใหมถ่า้ยาวเกนิขนาดบรรทดั 
แต่ถา้เราตอ้งการใหเ้วบบราวเซอรต์ดัขอ้ความ ณ ตําแหน่งทีก่ําหนดเราจะใชค้าํสัง่ Line Break <BR> โดยมี
รปูแบบดงัน้ี 

ขอ้ความ..... <BR> 

 
ตัวอย่างท่ี 2  break_rule.htm l 
<HTML> 
<HEAD><TITLE> Break Rule </TITLE></HEAD> 
<BODY> 
<P> 
      Microsoft ถกูตดัสนโดยศาลสหรัฐแลว้ิ  
      โดยศาลสงให ้ั่  Microsoft แยกบรษัิทออกเป็นบรษัิทยอ่ย ๆ  
<I>(ในยอ่หนา้ขา้งบนนี ้แมจ้ะมกีารกด Enter ขึน้บรรทัดใหม ่ 
แต ่HTML จะตคีวามเป็นบรรทัดเดยีว)</I> 
<P> 
      Microsoft ถกูตดัสนโดยศาลสหรัฐแลว้ิ <BR> 
      โดยศาลสงให ้ั่  Microsoft แยกบรษัิทออกเป็นบรษัิทยอ่ย ๆ <BR> 
<I>(สวนยอ่หนา้นีใ้ชคําสง่ ้ ั่  &lt;BR&gt; จงึขึน้บรรทัดใหม)่</I> 
</BODY> 
</HTML> 

 
คาํสัง่ยกเลกการขึ้ิ นบรรทดัใหม่ (No Break Rule) 
เมื่อเราตอ้งการยกเลกิคุณสมบตักิารตดัคําของเวบ็บราวเ์ซอร ์ เราสามารทําไดโ้ดยใชค้ําสัง่ <NOBR> 

โดยมรีปูแบบดงัน้ี 
<NOBR> 

http://se-ed.net/htmlbasic/example/head.html
http://se-ed.net/htmlbasic/example/break_rule.html
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.... ขอ้ความ .... 
 
</NOBR> 

 
ตัวอย่างท่ี 3  no_break.html 
<HTML> 
<HEAD><TITLE> Break Rule </TITLE></HEAD> 
<BODY> 
<NOBR> 
"The fist step toward success is identifying you own leadership strengths"<BR> 
 (กา้วแรกสคูวามสาเร็จ่ ํ  คอืการระบคุณุสมบตัเิดน่ของการเป็นผูนํ้าทีม่อียูใ่นตวัคณุ) 
</NOBR> 
</BODY> 
</HTML> 

 
ถ้าเราเปิดตวัอย่างขา้งต้น แลว้ย่อเวบ็บราวเซอร์ดู จะเหน็ไดว้่าบรรทดัแรกจะไม่มกีารตดัคําแมจ้ะเวน้

วรรตคไว ้จนเวบ็บราวเ์ซอรพ์บคาํสัง่ <BR> จงึทาํการตดัคาํขึน้บรรทดัใหม ่
 
คาํสัง่การจดัตาํแหนงของข้อความ่  (Paragraph Break) 
เราจะใชค้าํสัง่ <P> ในการจดัยอ่หน้าของขอ้ความในเวบ็เพจ ซึง่คาํสัง่ <P> นัน้ จะม ี Attributes เป็น

คาํสัง่เสรมิชว่ยในการจดัตาํแหน่งของยอ่หน้าคอื Alignment โดยมรีปูแบบดงัน้ี 
<P Align = "ตําแหน่ง"  > .... ขอ้ความ .... </P> 

 
ตาํแหน่งทีใ่ชใ้นการจดัยอ่หน้ามดีว้ยกนัสามลกัษณะคอื 

• Left จดัขอ้ความชดิซา้ยบรรทดั  
• Center จดัขอ้ความกึง่กลางบรรทดั  
• Right จดัขอ้ความชดิขวาบรรทดั  

โดยปกตคิา่เริม่ตน้ของ Alignment จะอยูท่ี ่Left คอืจดัขอ้ความชดิซา้ยของบรรทดั 
 

ตวัอยา่งที ่4  paragraph.html 
<HTML> 
<HEAD><TITLE> Paragraph </TITLE></HEAD> 
<BODY> 
<H4>การจัดยอ่หนา้ในเวบเพจ</H4><BR> 
<P ALIGN="Left"> 
ขอ้ความชดซายบรรทดัิ ้  
</P> 
<P ALIGN="Center"> 
ขอ้ความกึง่กลางบรรทัด 
</P> 
<P ALIGN="Right"> 
ขอ้ความชดขวาบรรทัดิ  
</P> 

http://se-ed.net/htmlbasic/example/no_break.html
http://se-ed.net/htmlbasic/example/paragraph.html
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คาํสัง่จดัวางข้อความก่ึงกลางบรรทดั (Center) 
ในการจดัวางตําแหน่งของขอ้ความดว้ยภาษา HTML นอกจากจะใชค้าํสัง่ <P Align= "ตําแหน่ง"> แลว้ 

เรายงัสามารถกําหนดกลุ่มขอ้ความหรอืรปูภาพใหอ้ยูก่ึง่กลางไดด้ว้ยคําสัง่ <CENTER> ทีม่รีปูแบบกระชบักว่า 
โดยมรีปูแบบดงัน้ี 

<CENTER> .... ขอ้ความ .... </CENTER> 

 
ซึง่ขอ้ความทีไ่ดจ้ะอยูก่ึง่กลางบรรทดั เหมาะกบัการสรา้งขอ้ความทีเ่ป็นหวัเรือ่ง  
 
ตวัอยา่งที ่5 center.html 
<HTML> 
<HEAD><TITLE> Center </TITLE></HEAD> 
<BODY> 
<H1><CENTER>การฝึกอบรมเชงปฏบิตักิาร เรือ่งิ </CENTER></H1> 
<H2><CENTER>การสรา้งเว็บเพจเบือ้งตน้</CENTER></H2> 
<H3><CENTER>วทิยากร อ.จักรภพ ใหมเ่สน</CENTER></H3>  
</BODY> 
</HTML> 

 
การตีเส้นแนวนอน (Horizontal Line) 
ภาษา HTML มคีาํสัง่ชว่ยในการตเีสน้แนวนอน เพือ่แยกเอกสารออกเป็นสว่น ๆ ใหง้า่ยต่อการดรูปูแบบ

เอกสารมากขึน้ โดยมรีปูแบบดงัน้ี 
<HR> 

 
สาํหรบัคาํสัง่ <HR> น้ีจะไมม่แีทก็ปิด เป็นคาํสัง่ในลกัษณะทีเ่รยีกวา่แทก็เปิด ซึง่ถา้เป็นคาํ default จะ

แสดงเสน้ขนาด 2 pixels เตม็จอภาพ แต่คาํสัง่ <HR> ยงัม ีAttributes ช่วยในการกําหนดความหนา, ความยาว, 
การจดัตาํแหน่ง และการกาํหนดความทบึของเสน้ โดยมรีปูแบบดงัน้ี 

<HR Size = "ความหนาของเสน้" 
    Width = "ความยาวของเสน้" 
    Align = "ตําแหน่งการจัดวาง"  
    Noshade> 

 
Size เป็นการกาํหนดความหนาใหก้บัเสน้ ขนาดปกต ิคอื 2 pixels 

Width เป็นการกาํหนดความยาวใหก้บัเสน้ สามารถกาํหนดเป็นทัง้ pixels และ % โดยปกติ
ถา้ไมก่าํหนด เสน้จะยาวเตม็จอภาพ 

Align เป็นการกาํหนดตาํแหน่งการจดัวางของเสน้ ประกอบดว้ย  

  Left คอื การจดัเสน้ชดิซา้ยของบรรทดั 
Center คอื การจดัเสน้อยูก่ึง่กลางบรรทดั 
Right คอื การจดัเสน้ชดิขาวของบรรทดั 

Noshade เป็นการกาํหนดแสดงเสน้ทบึไมม่กีารแรงเงาของเสน้ 

http://se-ed.net/htmlbasic/example/center.html
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ตวัอยา่งที ่6  horizontal_line.html 
 
<HTML> 
<HEAD><TITLE> Horizontal Line </TITLE></HEAD> 
<BODY> 
เสนขนาดปกติ้  
<HR> 
เสนความหนา ้ 5 
<HR Size="5"> 
เสนความหนา ้ 20 
<HR Size="20"> 
เสนความยาว ้ 200 
<HR Width="200"> 
เสนความยาว ้ 50% ของจอภาพ 
<HR Width="50%"> 
เสนความหนา ้ 20 ความยาว 20% 
<HR Szie="20" Width="20%"> 
เสนความหนา ้ 10 ความยาว 20% และอยูช่ดซายของบรรทดัิ ้  
<HR Szie="10" Width="20%" Align="Left"> 
เสนความหนา ้ 10 และแสดงเสนทบึโดยไมม่กีารแรเงาของเสน้ ้  
<HR Szie="10" Noshade> 
</BODY> 
</HTML> 

 

การจดัรปูแบบตวัอกัษร และการใช้สี 

คาํสัง่ในการกาํหนดแบบตวัอกัษร (Font Type) 
คาํสัง่ในการกําหนดแบบตวัอกัษรนัน้ เราใชแ้ทก็ <FONT> ซึง่แทก็น้ีสามารถทีจ่ะกําหนดไดต้ัง้แต่ แบบ

ตวัอกัษร (Font Face), ขนาดของตวัอกัษร (Font Size) และสขีองตวัอกัษร (Font Color) 
การกําหนดแบบตวัอกัษร หรอืทีเ่รยีกวา่ ฟอนต ์ (Font) โดยปกตคิ่าเริม่ตน้ของเวบ็บราวเซอรจ์ะกําหนด

เป็นแบบ Time New Roman เพื่อความหลากหลายของรปูแบบตวัอกัษรมากกวา่ 1 รปูแบบบนจอภาพของ
บราวเซอร ์ เราสามารถใชค้ําสัง่ <FONT> ตามดว้ย Attributes "FACE" เพื่อกําหนดรูปแบบการแสดงผล
ภาษาไทยให้กบัตวัอกัษรของเวบ็เพจของเราได้ ซึ่งการแสดงผลภาษาไทยนัน้มฟีอนต์ให้เลอืกหลายแบบ
ตวัอยา่งเช่น AngsanaUPC, CordiaUPC, BrowalliaUPC, MS Sans Serif เป็นตน้ แต่สาํหรบัฟอนตท์ีเ่หมาะสม
กบัการแสดงผลภาษาไทยในเวบ็บราวเซอร ์คอื MS Sans Serif โดยมรีปูแบบดงัน้ี 

<FONT Face = "ชอฟอนต์ื่ "> ... ขอ้ความ ... </FONT> 

 
ถา้ตอ้งการระบุมากกวา่ 1 ฟอนต ์ใหก้าํหนดรปูแบบดงัน้ี 
<FONT Face = "ชอฟอนต์ื่ 1",ชอฟอนต์ื่ 2",...> ... ขอ้ความ ... </FONT> 

 
ขอ้ดขีองการกาํหนดฟอนตไ์วม้ากกวา่ 1 ฟอนต ์กค็อื เมือ่เวบ็บราวเซอรห์าฟอนตท์ี ่1 ไมเ่จอกจ็ะหา

ฟอนตท์ี ่2 ต่อไปตามลาํดบั 
 
ตวัอยา่งที ่7 font_face.html 

http://se-ed.net/htmlbasic/example/horizontal_line.html
http://se-ed.net/htmlbasic/example/font_face.html
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<HTML> 
<HEAD><TITLE> Font Face </TITLE></HEAD> 
<BODY> 
 
<FONT Face="AngsanaUPC"> 
แบบตวัอกัษรแบบ AngsanaUPC 
</FONT> 
<BR> 
<FONT Face="Ms Sans Serif"> 
แบบตวัอกัษรแบบ Ms Sans Serif 
</FONT> 
<BR> 
 
<FONT Face="Comic Sans MS"> 
Font Style Comic Sans MS 
</FONT> 
<BR> 
 
<FONT Face="Bookman Old Style"> 
Font Style Bookman Old Style 
</FONT> 
<BR> 
 
</BODY> 
</HTML> 

 
เราสามารถกาํหนดขนาดของตวัอกัษรในคาํสัง่ <FONT> โดยใช ้Attributes "Size" ในภาษา HTML 

กาํหนดขนาดของตวัอกัษรได ้7 ขนาด โดยใชต้วัเลข 1-7 เป็นตวักาํหนด คา่เริม่ตน้จะมขีนาดเป็น 3 
<FONT Size = "ขนาด"> ... ขอ้ความ ... </FONT> 

 
ตวัอยา่งที ่8  font_size.html 
<HTML> 
<HEAD><TITLE> Font Face </TITLE></HEAD> 
<BODY> 
<FONT Size="1">Font Size 1</FONT><BR> 
<FONT Size="2">Font Size 2</FONT><BR> 
<FONT Size="3">Font Size 3</FONT><BR> 
<FONT Size="4">Font Size 4</FONT><BR> 
<FONT Size="5">Font Size 5</FONT><BR> 
<FONT Size="6">Font Size 6</FONT><BR> 
<FONT Size="7">Font Size 7</FONT><BR> 
</BODY> 
</HTML> 

 
การกาํหนดสใีหก้บัตวัอกัษรเราใช ้Attributes "Color" ในการกาํหนดสขีองตวัอกัษรทาํได ้2 วธิ ีคอื 

1. กําหนดจากชื่อของสมีาตรฐาน เป็นการกําหนดจากชื่อสมีาตรฐานโดยตรง เช่น Black, Red 
เป็นตน้  

http://se-ed.net/htmlbasic/example/font_size.html
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2. กําหนดจากรหสัเลขฐาน 16 จะใชก้ารอา้งองิเลขฐาน 16 ในระบบของหมายเลขส ี RGB (Red, 
Green, Blue) ซึง่มรีปูแบบของรหสัสเีป็น #RRGGBB โดยใชแ้ทนรหสัดว้ยเลขฐาน 16 ในช่วง 
0, 1,2,3,4,5,6,7,8,9,A,B,C,D,E,F ตามลาํดบั  

โดยมรีปูแบบดงันี ้
<FONT Color = "ชอสมาตรฐานื่ ี "> ... ขอ้ความ ... </FONT> 
 
หรอื 
<FONT Color = "#RRGGBB"> ... ขอ้ความ ... </FONT> 

 

ตวัอยา่งสมีาตราฐานในการแสดงผลบนเวบบราวเซอร ์(ในทีน้ี่ขอใช ้Internet Explorer เป็นหลกั) ทัง้ชือ่
ของส ีและรหสัเลขฐาน 16 มดีงัน้ี 

ชอมาตรฐานื่  ตวัเลขฐาน 16 ในระบบส ี
#RRGGBB 

สทีป่รากฏบนี
จอภาพ สทีไ่ด้ี  

Black #000000 สดาํี    
Blue #0000FF สนํา้เงนิเขม้ี    
Cyan #00FFFF สครามี    

Darkgray #A9A9A9 สเทาเขม้ี    
Gray #808080 สเทาี    

Green #008000 สเขยีวี    
Lightgray #D3D3D3 สเทาออ่นี    
Magenta #FF00FF สมว่งออ่นี    
Orange #FFA500 สสมี ้    

Pink #FFC0CB สชมพูี    
Red #FF0000 สแดงี    

White #FFFFFF สขาวี    
Yellow #FFFF00 สเหลอืงี    

ตวัอยา่งที ่9  font_color.html 
<HTML> 
<HEAD><TITLE> Font Color</TITLE></HEAD> 
<BODY> 
 
<FONT color="Blue">This is Blue Color</FONT><BR> 
<FONT color="Green">This is Green Color</FONT><BR> 
<FONT color="#FFA500">This is #FFA500</FONT><BR> 
 
</BODY> 
</HTML> 

 

http://se-ed.net/htmlbasic/example/font_color.html
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คาํสัง่ในการกาํหนดลกัษณะตวัอกัษร (Style) 
ในภาษา HTML มคีาํสัง่ทีช่ว่ยในการกาํหนดลกัษณะตวัอกัษรใหม้คีวามเดน่ชดั เพือ่ความเหมาะสมกบั

งานในลกัษณะต่าง ๆ โดยมรีปูแบบต่าง ๆ ดงัน้ี 

• การกาํหนดตวัอกัษรตวัหนา (Bold) ใชแ้ทก็ <B>  
• การกาํหนดตวัอกัษรตวัเอยีง (Italic) ใชแ้ทก็ <I>  
• การกาํหนดขดีเสน้ใตต้วัอกัษร (Underline) ใชแ้ทก็ <U>  
• การกาํหนดตวัอกัษรตวัพมิพด์ดี (Typewriter) ใชแ้ทก็ <TT>  
• การกาํหนดขดีเสน้พาดทบักลางตวัอกัษร (Strikethrough) ใชแ้ทก็ <S>  
• การกาํหนดตวัอกัษรตวัหอ้ย (Subscript) ใชแ้ทก็ <SUB>  
• การกาํหนดตวัอกัษรตวัยก (Superscript) ใชแ้ทก็ <SUP>  
• การกาํหนดตวัอกัษรตวัโต (Big) ใชแ้ทก็ <BIG>  
• การกาํหนดตวัอกัษรตวัเลก็ (Small) ใชแ้ทก็ <SMALL> 

<B> ... ขอ้ความ ... </B> 
<I> ... ขอ้ความ ... </I> 
<U> ... ขอ้ความ ... </U> 
<TT> ... ขอ้ความ ... </TT> 
<S> ... ขอ้ความ ... </S> 
<SUB> ... ขอ้ความ ... </SUB> 
<SUP> ... ขอ้ความ ... </SUP> 
<BIG> ... ขอ้ความ ... </BIT> 
<SMALL> ... ขอ้ความ ... </SMALL> 

 
ตวัอยา่งที ่10  style.html 
<HTML> 
<HEAD><TITLE> Font Face </TITLE></HEAD> 
<BODY> 
 
แบบตวัอกัษรปกต ิ
แบบตวัอกัษรหนา <B>Bold</B><BR> 
แบบตวัอกัษรเอยีง <I>Italic</I><BR> 
แบบตวัอกัษรขดีเสนใต ้้  <U>Underline</U><BR> 
แบบตวัอกัษรตวัพมิพด์ดี <TT>Typewriter</TT><BR> 
แบบตวัอกัษรขดีเสนพาดทับกลางตวัอกัษร้  <S>Strikethrough</S><BR> 
แบบตวัอกัษรตวัหอ้ย <SUB>Subscript</SUB><BR> 
แบบตวัอกัษรตวัยก <SUP>Superscript</SUP><BR> 
แบบตวัอกัษรตวัโต <BIG>Big</BIG><BR> 
แบบตวัอกัษรตวัเล็ก <SMALL>Small</SMALL> 
 
</BODY> 
</HTML> 

 
การกาํหนดสีพืน้หลงั 
การกาํหนดสพีืน้หลงัของเวบ็เพจเราสามารถทาํไดจ้ากแทก็ <BODY> โดยกาํหนดจาก Attributes 

"BGColor" โดยมรีปูแบบดงัน้ี 
 

http://se-ed.net/htmlbasic/example/style.html


 

 
กระทรวงเทคโนโลยสีารสนเทศและการสือ่สาร   15 

 

http://www.mict4u.net 

โครงการอบรมเพ่ือการสงเสริมและพฒันาการใช ้่ ICT  
ณ ศนูยก์ารเรียนรู้ ICT ชุมชน 

กําหนดสพืน้หลงัจากชอสมาตรฐานี ื่ ี  
<BODY BGColor = "สพืน้หลงัี "> 
.... 
</BODY> 
 
กําหนดสพืน้หลงัจากเลขฐาน ี 16 
<BODY BGColor = "#RRGGBB"> 
.... 
</BODY> 

 
ตวัอยา่งที ่11  bgcolor.html 
<HTML> 
<HEAD><TITLE> BGColor </TITLE></HEAD> 
<!-- BODY BGColor="Yellow" --> 
<BODY BGColor="#FFFF00"> 
The Internet is a collection of information stored in computers physically located 
throughout the world.<BR> 
Much of the information on the Internet is organized onto electronic pages. You'll bring 
one page to your computer screen, discover its contents, and have the option of 
bringing more pages of information. 
</BODY>  
</HTML> 

 
การกาํหนดสีให้กบัตวัอกัษรทัง้เอกสาร 
การกาํหนดสใีหก้บัตวัอกัษรทัง้เวบ็เพจเราสามารถทาํไดจ้ากแทก็ <BODY> โดยกาํหนดจาก Attributes 

"Text" โดยมรีปูแบบดงัน้ี 
กําหนดสพืน้หลงัจากชอสมาตรฐานี ื่ ี  
<BODY Text = "สพืน้หลงัี "> 
.... 
</BODY> 
 
กําหนดสพืน้หลงัจากเลขฐาน ี 16 
<BODY Text = "#RRGGBB"> 
.... 
</BODY>  

ตวัอยา่งที ่12  body_text.html 
 
<HTML> 
<HEAD><TITLE> Heading </TITLE></HEAD> 
<!-- BODY Text="Red" --> 
<BODY Text="#FF0000"> 
The Internet is a collection of information stored in computers physically located 
throughout the world.<BR> 
Much of the information on the Internet is organized onto electronic pages. You'll bring 
one page to your computer screen, discover its contents, and have the option of 
bringing more pages of information. 
</BODY>  
</HTML> 

 
 

http://se-ed.net/htmlbasic/example/bgcolor.html
http://se-ed.net/htmlbasic/example/body_text.html
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การกาํหนดเครื่องหมายหวัข้อและเลขลาํดบั 

คาํสัง่ในการแสดงรายการแบบไมมีลาํดบั่  (Unordered List) 
Unordered List หรอื Bullet List นัน้ ในภาษา HTML ไดก้าํหนดคาํสัง่ในการอาํนวยความสะดวกในการ

สรา้ง Bullet ขึน้ไวด้ว้ย เพือ่แสดงเครือ่งหมายหน้าหวัขอ้เรือ่งหรอืลาํดบัของรายการต่าง ๆ โดยไมม่กีาร
เรยีงลาํดบั โดยมรีปูแบบดงัน้ี 

<UL> 
    <LI> ... ขอ้ความ ... 
    <LI> ... ขอ้ความ ... 
    <LI> ... ขอ้ความ ... 
    ...    ........... 
</UL> 
 
ตวัอยา่งที ่13  bullet1.html 
<HTML> 
<HEAD><TITLE> List Item </TITLE></HEAD> 
<BODY> 
<UL>Viewing the Navigator Window 
    <LI>Window and frames 
    <LI>Colors and underlining 
    <LI>Company logo 
    <LI>Progress bar 
    <LI>Status message area 
</UL>  
</BODY> 
</HTML> 

 
เรายงัสามารถระบุชนิดของเครือ่งหมายไดด้ว้ย Attributes "Type" ในแทก็ <UL> หรอื <LI> โดยมี

รปูแบบดงัน้ี 
<UL Type = "ชนดิของเครือ่งหมาย"> 
<LI Type = "ชนดิของเครือ่งหมาย"> 
 
ชนิดของเครือ่งหมายมดีว้ยกนั 3 แบบ ดงัน้ี 

ชนดิของเครือ่งหมาย สญญาลกัษณ์ทีป่รากฏั  

Disc 
•    

Circle 
o    

Square 
    

 
ตวัอยา่งที ่14 bullet2.html 
<HTML> 
<HEAD><TITLE> List Item </TITLE></HEAD> 
<BODY> 
 
<UL Type="Circle">การศกษาวชิาพืน้ฐานของคณะวทิยาศาสตร ์สาขาวทิยาการคอมพวิเตอร์ึ  
ไดแ้ก ่

http://se-ed.net/htmlbasic/example/bullet1.html
http://se-ed.net/htmlbasic/example/bullet2.html
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คาํสัง่ในการแสดงรายการแบบเป็นลาํดบั (Ordered List) 
เราสามารถแสดงรายการแบบเป็นลาํดบั คอื Ordered List หรอื Number List ได ้โดยการใชต้วัเลขหรอื

ตวัอกัษรเป็นตวักาํหนดแสดงลาํดบั โดยมรีปูแบบดงัน้ี 
<OL Type = "ชนดิของตวัเลข" Start = "ตวัเลขเริม่ตน้"> 
    <LI> ... ขอ้ความ ... 
    <LI> ... ขอ้ความ ... 
    <LI> ... ขอ้ความ ... 
    ...    ........... 
</OL> 

 
ชนิดของ Type กาํหนดเลขลาํดบัไดด้งัน้ี 

ชนดิของ Type สงทีป่รากฏิ่  

A แสดงตวัอกัษรพมิพใ์หญ ่(Caplital letters) 

a แสดงตวัอกัษรพมิพเ์ล็ก (Small letters) 

I แสดงตวัเลขโรมันตวัพมิพใ์หญ ่(Large Roman numerals) 

i แสดงตวัเลขโรมันตวัพมิพเ์ล็ก (Small Roman numerals) 

1 แสดงตวัเลขอารบกิ (Small Roman numerals) 
* เป็นคา่ default * 

 
ตวัอยา่งที ่15  order_list.html 
<HTML> 
<HEAD><TITLE> Order List </TITLE></HEAD> 
<BODY> 
 
<OL Type="I">My computer in my dream 
   <LI>Inter Pentium 4 processor 2.0 GHz 
   <LI>RDRAM 256 MB 
   <LI>Harddisk 50 GB ATA-100 
   <LI>52X CD-Rom Drive 
   <LI>Speakers (Labtec) 160 Watt 
   <LI>Asus GeForce3 64 MB 
   <LI>Creative Sound Baster 

http://se-ed.net/htmlbasic/example/order_list.html
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   <LI>Monitor Sony Wega 20" 
</OL>  
 
</BODY> 
</HTML> 

 
 

การสร้างตาราง 

คาํสัง่ในการสร้างตาราง (Table) 
การสรา้งเวบเพจในปจจุบนัมกีารนําตารางเขา้มาเกีย่วขอ้งกบัหลาย ๆ สว่นั  ตัง้แต่การสรา้งตารางเพือ่

แสดงความสมัพนัธใ์นลกัษณะแถว (Row) และคอลมัน์ (Column) รวมถงึการแบง่ขอบเขตใหก้บัขอ้ความเพือ่การ
จาํกดัและควบคุมขอ้ความใหอ้ยูใ่นสว่นทีเ่ราตอ้งการ 

คาํสัง่สาํหรบัสรา้งตารางประกอบดว้ยคาํสัง่ดงัน้ี 
Tag คาํอธบิาย 

<TABLE> ... </TABLE> คําสงในการสรา้งตารางั่  
<CAPTION> ... </CAPTION> คําสงในการกําหนดขอ้ความกํากบัตารางั่  

<TR> ... </TR> คําสงในการกําหนดแถวของตาราง ั่ 1 แถว 
<TH> ... </TH> คําสง่ัในการกําหนดสวนหวัของตารางแถวแรก่  
<TD> ... </TD> คําสงในการกําหนดสวนของขอ้มลูในแถวั่ ่  หรอืทําคอลมัน ์

 
สาํหรบัโครงสรา้งของคาํสัง่ในการสรา้งตารางมดีงัน้ี 
<TABLE> 
   <CAPTION>   ขอ้ความกํากบัตาราง   </CAPTION> 
   <TR> 
      <TH>   ขอ้ความสวนหวั่     </TH> 
      .................... 
      .................... 
   </TR> 
   <TR> 
      <TD>   ขอ้ความสวนของขอ้มลู่     </TD> 
      ........................ 
      ........................ 
   </TR> 
 
   <TR> 
      <TD>   ขอ้ความสวนของขอ้มลู่     </TD> 
      ........................ 
      ........................ 
   </TR> 
   ........................ 
   ........................ 
   ........................  
</TABLE> 

 
ตวัอยา่งที ่16  table1.html 
<HTML> 
<HEAD><TITLE> Table Tag </TITLE></HEAD> 

http://se-ed.net/htmlbasic/example/table1.html


 

 
กระทรวงเทคโนโลยสีารสนเทศและการสือ่สาร   19 

 

http://www.mict4u.net 

โครงการอบรมเพ่ือการสงเสริมและพฒันาการใช ้่ ICT  
ณ ศนูยก์ารเรียนรู้ ICT ชุมชน 

<BODY> 
<CENTER> 
Example Data 
<H2>Report Sale 2001</H2>  
<TABLE> 
   <TR> 
      <TH>Month</TH> 
      <TH>Sale A</TH> 
      <TH>Sale B</TH> 
      <TH>Sale C</TH> 
   </TR> 
   <TR> 
      <TD>January</TD> 
      <TD>500</TD> 
      <TD>800</TD> 
      <TD>700</TD> 
   </TR> 
   <TR> 
      <TD>February</TD> 
      <TD>1200</TD> 
      <TD>1000</TD> 
      <TD>300</TD> 
   </TR> 
   <TR> 
      <TD>Mar</TD> 
      <TD>900</TD> 
      <TD>400</TD> 
      <TD>600</TD> 
   </TR>  
</TABLE> 
</CENTER> 
</BODY> 
</HTML> 

 
เรายงัสามารถใช ้Attributes เพือ่ใหเ้วบบราวเซอรแ์สดงตารางใหช้ดัเจนยิง่ขึน้ Attributes ต่าง ๆ มดีงัน้ี 

Attributes คาํอธบิาย 

Align 

กําหนดการวางตําแหน่งตางราง ม ี3 ลกัษณะ 
- Left กําหนดจัดวางชดซายิ ้  (เป็นคา่ default) 
- Right กําหนดจัดวางชดขวาิ  
- Center กําหนดจัดวางกึง่กลาง 

Border กําหนดแสดงความหนาของเสนตาราง มหีน่วยเป็น ้ Pixel 
Height กําหนดความสงูของตาราง มหีน่วยเป็น Pixel และ Percent 

Width กําหนดความกวา้งของตาราง มหีน่วยเป็น Pixel และ 
Percent 

CellSpacing กําหนดชองวา่งระหวา่งตาราง่  
CellPadding กําหนดชอ่งวา่งระหวา่งบรรทดัของตาราง 

 
การกาํหนดคา่ต่าง ๆ ของ Attributes ทีก่ลา่วมาแลว้ ความแตกต่างของการกาํหนดคา่เป็น pixel และ

เป็น percent นัน้มคีวามแตกต่างกนัดงัน้ี 

• พกิเซล (Pixel) การกาํหนดคา่เป็นแบบพกิเซล เมือ่การลดขนาดของเวบบราวเซอรต์ารางจะไม่
ลดขนาดตามความกวา้ง หรอืยาวของเวบบราวเซอร ์
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• เปอรเ์ซน็ต ์(Percent หรอื %) ถา้กาํหนดคา่ในลกัษณะของ Percent เมือ่บราวเซอรม์กีารลด
ขนาดลง ขนาดของตารางจะลดสดัสว่นตามขนาดของตวัเวบบราวเซอรด์ว้ย 

ตวัอยา่งที ่17  table2.html 
<HTML> 
<HEAD><TITLE> Table Tag </TITLE></HEAD> 
<BODY> 
<CENTER> 
Example Data 
<H2>Report Sale 2001</H2> 
<TABLE Border="3" CellSpacting="5" CellPadding="3"> 
   <TR> 
      <TH>Month</TH> 
      <TH>Sale A</TH> 
      <TH>Sale B</TH> 
      <TH>Sale C</TH> 
   </TR> 
   <TR> 
      <TD>January</TD> 
      <TD>500</TD> 
      <TD>800</TD> 
      <TD>700</TD> 
   </TR> 
   <TR> 
      <TD>February</TD> 
      <TD>1200</TD> 
      <TD>1000</TD> 
      <TD>300</TD> 
   </TR> 
   <TR> 
      <TD>Mar</TD> 
      <TD>900</TD> 
      <TD>400</TD> 
      <TD>600</TD> 
   </TR>  
</TABLE> 
</CENTER> 
</BODY> 
</HTML> 

 
คาํสัง่ในการกาํหนดสี และการจดัตาํแหนงของข้อมลูในตาราง่   
ในการสรา้งตารางในภาษา HTML ม ีAttributes ทีช่ว่ยเพิม่สสีนัและความเหมาะสมใหก้บัตาราง คอื  

• Align ใชก้าํหนดการจดัตาํแหน่งของขอ้มลูในตางราง ไมว่า่จะเป็นขอ้ความหรอืภาพ กาํหนดได ้
3 ลกัษณะ 
 Left กาํหนดการจดัวางแบบชดิขอบซา้ยของตาราง 
 Right กาํหนดการจดัวางแบบชดิขอบขาวของตาราง 
 Center กาํหนดการจดัวางแบบกึง่กลางของตาราง  

• BGColor เป็นการกาํหนดพืน้สภีายในตารางทีอ่ยูใ่นแถวนัน้ 

http://se-ed.net/htmlbasic/example/table2.html
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ตวัอยา่งที ่18  table3.html 
<HTML> 
<HEAD><TITLE> Table Tag </TITLE></HEAD> 
<BODY> 
<CENTER> 
<H2>Report Sale 2001</H2> 
<TABLE Border="3" CellSpacting="5" CellPadding="3"> 
<CAPTION Aling="Bottom"> 
Summation Sale Report 
</CAPTION> 
   <TR Aling="Center" BGColor="Whitegreen"> 
      <TH>Month</TH> 
      <TH>Sale A</TH> 
      <TH>Sale B</TH> 
      <TH>Sale C</TH> 
   </TR> 
   <TR Align="Center" BGColor="Yellow"> 
      <TD>January</TD> 
      <TD>500</TD> 
      <TD>800</TD> 
      <TD>700</TD> 
   </TR> 
   <TR Align="Center" BGColor="Skyblue"> 
      <TD>February</TD> 
      <TD>1200</TD> 
      <TD>1000</TD> 
      <TD>300</TD> 
   </TR> 
   <TR Align="Center" BGColor="Pink"> 
      <TD>Mar</TD> 
      <TD>900</TD> 
      <TD>400</TD> 
      <TD>600</TD> 
   </TR>  
</TABLE> 
</CENTER> 
</BODY> 
</HTML> 

 

การนํารปูภาพมาใช้กบัเวบเพจ 

ชนดของรปูภาพิ  
การนํารปูภาพมาใสใ่นเวบเพจเป็นสว่นหน่ึงทีส่รา้งความน่าสนใจใหก้บัเวบเพจเป็นอยา่งมาก โดยเฉพาะ

การสรา้งเวบเพจในปจจุบนักา้วไปถงึขัน้มกีารตอบโต้กบัผูท้ีเ่ขา้ชมเวบเพจั  หรอืที่เรยีกกว่า อนิเตอร์แอค็ทฟี 
(Interactive) การนํารปูภาพในใชใ่นเวบเพจยิง่มคีวามจาํเป็นมากยิง่ขึน้ 

ในการแสดงผลในเวบเพจนัน้ ภาพในแบบทีเ่หมาะสมคอืภาพในแบบ GIF หรอื JPEG เน่ืองจากภาพที่
ไดจ้ะมขีนาดเลก็ ทาํใหแ้สดงผลไดอ้ยา่งรวดเรว็  

1. Graphics Interchange Format (GIF) เป็นภาพทีม่กีารบบีอดัขอ้มลู ภาพจงึมขีนาดเลก็ แต่สทีี่
รปูภาพในแบบ GIF นัน้สามารถแสดงผลไดเ้พยีง 256 ส ีจงึเหมาะกบัภาพในลกัษณะภาพวาด ไฟลภ์าพแบบ 
GIF มอียูด่ว้ยกนั 2 ชนิด คอื 

http://se-ed.net/htmlbasic/example/table3.html
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- GIF87a เป็นไฟล ์GIF ทัว่ไป 
- GIF89a เป็นไฟล ์GIF ทีส่ามารถเคลือ่นไหวได ้หรอืทีเ่รยีกวา่ GIF Animation 

ไฟลภ์าพแบบ GIF ทัง้สองชนิดสามารถปรบัการแสดงผลได ้3 แบบ ไดแ้ก่ 
- แบบ Interlaced จะทาํการแสดงภาพออกเป็นช่วง ๆ แทนทีจ่ะแสดงไล่ลงมาจากบนลงล่าง

ตามปกต ิ
- แบบ Progressive จะทาํการแสดงภาพแบบหยาบ ๆ ก่อน แลว้คอ่ย ๆ ชดัขึน้ 
- แบบ Transparent Background จะแสดงภาพโดยไมม่พีืน้ฉากหลงั 

2. Joint Photographic Experts Group (JPEG หรอื JPG) เป็นรปูภาพทีถู่กบบีอดัขอ้มลูไว ้โดยใช้
เทคนิค Lossy ซึง่คุณภาพของภาพทีไ่ดจ้ะมคีุณภาพลดลงตามขนาดทีบ่บีอดัขอ้มลู แต่ไมจ่าํกดัจาํนวนส ี ไฟล์
ภาพแบบ JPEG เหมาะสาํหรบัภาพในลกัษณะภาพถ่าย 

 
คาํสัง่ในการใสรปูภาพในเวบเพจ่  (Image)  
เราจะใชแ้ทก็ <IMG> ในการนําภาพเขา้มาแสดงผลในเวบเพจ โดยมรีปูแบบดงัน้ี  
<IMG SRC = "ไฟลภ์าพ"> 
 
สาํหรบั Attributes ทีใ่ชร้ะบุตาํแหน่งของรปูภาพคอื SRC หรอื Source เราสามารถทีจ่ะชีต้าํแหน่งทีเ่กบ็

ภาพได ้เชน่ <IMG SRC="http://www.north.rit.ac.th/image/logo.gif"> เป็นตน้  

 
ตวัอยา่งที ่19  image1.html 
<HTML> 
<HEAD><TITLE> Image </TITLE></HEAD> 
<BODY> 
   <CENTER> 
      <IMG SRC="mypic.jpg"> 
   </CENTER> 
</BODY> 
</HTML> 

 
ถา้เราตอ้งการใสค่าํอธบิายภาพ ภาษา HTML ม ี Attributes ทีช่่วยทาํในสว่นน้ี คอื ALT (Alternative 

Text) ประโยชน์สาํหรบั Attributes น้ีคอื เมือ่ผูใ้ชเ้วบบราวเซอรท์ีไ่มร่องรบัการแสดงผลในแบบกราฟฟิค ในสว่น
ของภาพจะมขีอ้ความขึน้มาอธบิายในสว่นนัน้ โดยมรีปูแบบดงัน้ี 

<IMG SRC = "ไฟลภ์าพ" ALT = "คําอธบิาย"> 
 
ตวัอยา่งที ่20  image2.html 
<HTML> 
<HEAD><TITLE> Image </TITLE></HEAD> 
<BODY> 
   <CENTER> 
      <IMG SRC=" mypic.jpg" ALT="รปูใครเอย่"> 
   </CENTER> 
</BODY> 
</HTML> 

 

http://se-ed.net/htmlbasic/example/image1.html
http://se-ed.net/htmlbasic/example/image2.html
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การนํารปูภาพทาํเป็นพืน้หลงั 
เราสามารถนํารปูภาพไปประกอบเป็นพืน้หลงัหรอืทีเ่รยีกวา่วอลลเ์ปเปอร ์ (Wall Paper) ของเวบเพจได ้

โดยกาํหนดในสว่นของแทก็ Body ซึง่ใช ้Attributes Background โดยมรีปูแบบดงัน้ี 
<BODY Background = "ไฟลภ์าพ"> 

 
ตวัอยา่งที ่21  image_background.html 
<HTML> 
<HEAD><TITLE> Wall Paper </TITLE></HEAD> 
<BODY Background="logo_bg.gif"> 
   <CENTER> 
      We are students 
   </CENTER> 
</BODY> 
</HTML> 

 
 

การเช่ือมโยงเวบ็เพจ (Link) 

การเชื่อมโยงเวบ็เพจ หรอืทีเ่รยีกวา่ลงิค ์(Link) ถอืวา่เป็นคุณสมบตัทิีส่าํคญัของภาษา HTML ดงัจะเหน็
ไดจ้ากเวบ็เพจทัว่ ๆ ไป จุดเชือ่มโยงเวบ็เพจอาจจะเป็นขอ้ความหรอืรปูภาพกไ็ด ้

 
การสร้างจดุเช่ือมโยงข้อความ (Text Link) 
ในการเชื่อมโยงเวบเพจเราจะใชแ้ทก็ <A> โดยการกําหนดขอ้ความในเอกสาร HTML เป็นจุดเชื่อมโยง 

โดยมรีปูแบบดงัน้ี 
<A HREF = "URL"> ขอ้ความ </A> 

 
A HREF หมายถงึ Hypertext Reference สว่น URL (Uniform Resource Location) คอื รปูแบบ

มาตรฐานทีเ่ป็นแหลง่ทีข่อใชบ้รกิารอนิเทอรเ์น็ต โดยเขยีนอยูใ่นรปูแบบดงัน้ี 
โปรโตคอล://ชอโฮสื่ .โดเมน/ชอไฟล์ื่  
 
ตวัอยา่งเชน่  
 http://www.microsoft.com/ 
 ftp://ftp.nectec.or.th/ 
 http://www.north.rit.ac.th/index.html 
 
ตวัอยา่งที ่22  link1.html 
<HTML> 
<HEAD><TITLE>Link</TITLE></HEAD> 
<BODY> 
<CENTER><H2>สภาบนัการศกษาึ </H2></CENTER><BR> 
<A HREF="http://www.north.rit.ac.th/">สถาบนัเทคโนโลยรีาชมงคล วทิยาเขตภาคพายัพ
</A><BR> 
<A HREF="http://www.ru.ac.th/">มหาวทิยาลยัรามคําแหง</A><BR> 
<A HREF="http://www.cu.ac.th/">จฬุาลงกรณ์มหาวทิยาลยั</A><BR> 
<A HREF="http://www.tu.ac.th/">มหาวทิยาลยัธรรมศาสตร<์/A><BR> 

http://se-ed.net/htmlbasic/example/image_background.html
http://se-ed.net/htmlbasic/example/link1.html
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การสร้างจดุเช่ือมโยงกบัรปูภาพ (Graphic Link) 
เป็นการกาํหนดใหร้ปูภาพเป็นจุดเชือ่มโยง โดยมรีปูแบบดงัน้ี 
<A HREF = "URL"><IMG SRC = "ชอไฟล์ื่ "></A> 

 
ตวัอยา่งที ่23  link2.html 
<HTML> 
<HEAD><TITLE>Link</TITLE></HEAD> 
<BODY> 
<CENTER> 
<H2>หนังสอพมิพไ์ทยื </H2> 
<P> 
<A HREF="http://www.komchadluek.com/"> 
<IMG SRC="komchadluek.gif" BORDER="0"> 
</A> 
<P> 
<A HREF="http://www.thairath.com/"> 
<IMG SRC="thairath.gif" BORDER="0"> 
</A> 
</CENTER>  
</BODY> 
</HTML> 

 
การกาํหนดสีให้กบัจดุเช่ือมโยงเวบเพจ 
การสรา้งเวบเพจดว้ยภาษา HTML นัน้ จุดเชื่อมโยงขอ้ความทีเ่ราสรา้งขึน้จะมสีทีีแ่ตกต่างจากปกต ิ

พรอ้มทัง้มเีสน้ใตบ้ง่บอกจุดเชือ่มโยงดว้ย เราจะกาํหนดสขีอง Link ในเวบเพจจากแทก็ Body โดยมรีปูแบบดงัน้ี 
<BODY Attributes = "ชอสมาตราฐานื่ ี "> 
 
หรอื 
 
<BODY Attributes = "#RRGGBB"> 
 
Attributes ทีใ่ชใ้นการกาํหนดสมีดีว้ยกนัดงัน้ี 

BGCOLOR กาํหนดสพีืน้หลงัใหก้บัเวบเพจ 

TEXT กาํหนดสตีวัอกัษรปกต ิ

LINK กาํหนดสตีวัอกัษรทีเ่ป็นจุดเชือ่มโยง 

VLINK (Visited Link) กาํหนดสตีวัอกัษรทีท่าํการคลกิเพือ่ไปยงัเปาหมายแลว้้  

ALINK (Active Link) กาํหนดสตีวัอกัษรทีก่าํลงัคลกิไปยงัเปาหมาย้  

 
 
 
 

http://se-ed.net/htmlbasic/example/link2.html
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ตวัอยา่งที ่24  link3.html 
<HTML> 
<HEAD><TITLE>Link</TITLE></HEAD> 
<BODY TEXT="RED" LINK="BLUE" VLINK="GREEN" ALINK="ORANGE"> 
<CENTER><H2>สภาบนัการศกษาึ </H2></CENTER><BR> 
<A HREF="http://www.north.rit.ac.th/">สถาบนัเทคโนโลยรีาชมงคล วทิยาเขตภาคพายัพ
</A><BR> 
<A HREF="http://www.ru.ac.th/">มหาวทิยาลยัรามคําแหง</A><BR> 
<A HREF="http://www.cu.ac.th/">จฬุาลงกรณ์มหาวทิยาลยั</A><BR> 
<A HREF="http://www.tu.ac.th/">มหาวทิยาลยัธรรมศาสตร<์/A><BR> 
</BODY> 
</HTML> 

 
การเช่ือมโยงระหวางเวบ็เพจ่  

 ในการระบุตําแหน่งทีอ่ยู่สําหรบัลงิค์นัน้ ถ้าอยู่ต่างเวบ็ไซต์กนัจะตอ้งระบุไวใ้หค้รบถ้วน ตามตวัอย่างที ่
22-24 ทีผ่า่นมา  แต่ถา้เป็นไฟล ์HTML ในเวบ็ไซตเ์ดยีวกนัเราสามารถละชือ่เวบ็ไซตไ์ด ้เหลอืเพยีงชือ่ไฟลก์พ็อ 
 
 ตวัอยา่งที ่25  link3.html 

<HTML> 
<HEAD><TITLE>Link</TITLE></HEAD> 
<BODY> 
<CENTER><H2>สภาบนัการศกษาึ </H2></CENTER><BR> 
<A HREF="head.html">ตวัอยา่งที ่1</A><BR> 
<A HREF="paragraph.html">ตวัอยา่งที ่4</A><BR> 
<A HREF=" font_size.html">ตวัอยา่งที ่8</A><BR> 
<A HREF=" order_list.html">ตวัอยา่งที ่15</A><BR> 
<A HREF=" table3.html">ตวัอยา่งที ่18</A><BR> 
</BODY> 
</HTML> 

 

  

http://se-ed.net/htmlbasic/example/link3.html
http://se-ed.net/htmlbasic/example/head.html
http://se-ed.net/htmlbasic/example/paragraph.html
http://se-ed.net/htmlbasic/example/head.html
http://se-ed.net/htmlbasic/example/head.html
http://se-ed.net/htmlbasic/example/head.html
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9ตอนท่ี 2 เทคนคการสร้างิ  และตกแตงภาพ่  ด้วย Adobe Photoshop CS3 

 
Adobe Photoshop CS3 คืออะไร  
Adobe Photoshop CS3 เป็นโปรแกรมคอมพวิเตอรท์ีร่วบรวมเครือ่งมอืสาํหรบัตกแต่งภาพประสทิธภิาพสงู เพือ่
การทาํงานระดบัมาตรฐานสาํหรบันกัออกแบบมอือาชพีทีต่อ้งการสรา้งสรรคง์านกราฟิกทีโ่ดดเดน่ ทัง้งานทีใ่ชบ้น
เวบ็และงานสิง่พมิพ ์ 

ความละเอียดของภาพกราฟกิ   
ภาพทีป่รากฏบนหน้าจอคอมพวิเตอรน์ัน้ เกดิจากจุดสีเ่หลีย่มเลก็ๆ ของสทีีเ่ราเรยีกวา่ พกิเซล (Pixel) (พกิเซล
เป็นองคป์ระกอบทีเ่ลก็ทีส่ดุของภาพ) มาประกอบกนัเป็นภาพขนาดต่างๆ  
ความละเอยีดของภาพจะมหีน่วยวดัป็น พกิเซล/ตารางน้ิว และงานกราฟิกในแต่ละแบบกจ็ะใชค้วามละเอยีดที่
แตกต่างกนั ดงัน้ี  

• ภาพทีแ่สดงบนหน้าจอคอมพวิเตอร ์เชน่ หน้าเวบ็ หรอืงานพรเีซนเตชัน่ ใชค้วามละเอยีด 72 พกิเซล/
ตารางน้ิว  

• ภาพถ่ายทัว่ๆไป ใชค้วามละเอยีด 150 พกิเซล/ตารางน้ิว  
• ภาพในงานพมิพ ์ใชค้วามละเอยีด 300 พกิเซล/ตารางน้ิว  

 

พืน้ท่ีการทาํงาน (Work Area)  

Work Area หรอืพืน้ทีก่ารทาํงานของโปรแกรม Adobe Photoshop จะประกอบดว้ยเครือ่งมอืสาํหรบัการตกแต่ง
ไฟลภ์าพต่าง ๆ ดงัน้ี  

1. Menu bar คอืสว่นทีแ่สดงชือ่เมนูต่างๆ ของโปรแกรม กจ็ะประกอบดว้ย 
File , Edit , Image , Layer , Select , Filter , View , Window , Help  

1.1 File หมายถงึ คาํสัง่เกีย่วกบัการจดัเกบ็และเรยีกใชไ้ฟลร์ปูภาพต่างๆ  
1.2 Edit หมายถงึ คาํสัง่เกีย่วกบัการแกไ้ขลกัษณะของรปูภาพและ Image ต่างๆ  
1.3 Image หมายถงึ คาํสัง่การจดัการรปูภาพและ Image ต่างเชน่ การเปลีย่นสแีละการ เปลีย่น

ขนาด  
1.4 Layer หมายถงึ ชัน้หรอืลาํดบัของรปูภาพและวตัถุทีเ่ราตอ้งการจะทาํ Effects  
1.5 Select เป็นคาํสัง่การเลอืกพืน้ทีห่รอืสว่นต่างของรปูภาพและวตัถุในการทีจ่ะเลน่ Effects ต่างๆ  
1.6 Filter เป็นคาํสัง่การเลน่ Effects ต่างๆสาํหรบัรปูภาพและวตัถุ  
1.7 View เป็นคาํสัง่เกีย่วกบัมมุมองของภาพและวตัถุในลกัษณะต่างๆ เชน่ การขยายภาพ และ

ยอ่ภาพใหด้เูลก็  
1.8 Window เป็นสว่นคาํสัง่ในการเลอืกใชอุ้ปกรณ์เสรมิต่างๆทีจ่าํเป็นในการใชส้รา้ง Effects ต่างๆ  
1.9 Help เป็นคาํสงัเพ่ือแนะนาํเกยวกบการใชโ้ปรแกรมฯและจะมีลายละเอียดของโปรแกรม่ ี่ ั  อยใูนนนั่ ้   

2. Toolbox คอืสว่นของอุปกรณ์ต่าง ๆ ทีใ่ชใ้นการสรา้งชิน้งานหรอืตกแต่งภาพ  
3. Tool options bar คอืสว่นทีก่าํหนดคุณสมบตัขิองอุปกรณ์ทีเ่ลอืกจาก Toolbox  
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4. Palettes คอืสว่นทีใ่ชต้รวจสอบและกาํหนดคุณสมบตัต่ิาง ๆ ใหก้บัรปูภาพ  
5. Status bar คอืสว่นทีแ่สดงรายละเอยีดต่าง ๆ ของชิน้งาน เชน่ ขนาดของมมุมองรปูภาพ ขนาดของ

ไฟล ์คาํแนะนําการใชง้านของอุปกรณ์ทีเ่ลอืกจาก Toolbox  

 

 

เครื่องมือตางๆ่  (Toolbox) 

  
หมายเหตุ ปุ่ม Toolbar ท่ีมีเคร่ืองหมายสามเหล่ียมเลก็ๆ อยดูา้นลางขวาเม่ือกดปุ่มสามเหล่ียมดงักลาว่ ่ ่  โปรแกรมจะ

แสดงเคร่ืองมืออ่ืนๆ ออกมาเชน่   
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การเปดไฟลภ์าพิ  (Open)  

1. คลกิทีเ่มนูคาํสัง่ File ทีแ่ถบ Menu bar จากนัน้เลอืกคาํสัง่ Open  

 
 
2. จะปรากฏ Dialog แสดงรายชือ่ไฟลต่์าง ๆ ดงัภาพ เพือ่เลอืกไฟลท์ีต่อ้งการเปิดมาใชง้าน  
 

 
 

คลกิเลอืกไฟลท์ีต่อ้งการเปิดใชง้าน จากนัน้คลกิปมุ่ Open  3. 
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การสร้างไฟลใ์หม่ (New)  

1. คลกิทีเ่มนูคาํสัง่ File ทีแ่ถบ Menu bar จากนัน้เลอืกคาํสัง่ New  
 

 
2. จะปรากฏ Dialog สาํหรบักาํหนดคุณสมบตัต่ิาง ๆ ของไฟลภ์าพดงัน้ี  

 

 
- Name คอื ชือ่ของชิน้งาน สามารถกาํหนดใหมเ่องได ้ชือ่น้ีจะไประบุทีช่ ือ่ไฟลต่์อไป  
- Preset คอื ขนาดงานทีโ่ปรแกรมกาํหนดมาให ้ซึง่มหีลากหลายขนาดใหเ้ลอืก หรอื

สามารถกาํหนดเองจากชอ่ง Width และ Height ได ้ 
- Width คอื ขนาดความกวา้งของงาน (จากซา้ยไปขวา) โดยกาํหนดหน่วยและขนาดไดเ้อง 

จากรปู คอื 1024 Pixels  
- Height คอื ขนาดความกวา้งของงาน (จากบนลงลา่ง) โดยกาํหนดหน่วยและขนาดไดเ้อง 

จากรปู คอื 768 Pixels  
- Resolution คอื ความละเอยีดของภาพ โดยใสต่วัเลขคา่ความละเอยีดของภาพ เชน่ งาน

เวบ็หรอืรปูทีแ่สดงบนคอมพวิเตอรเ์ทา่กบั 72 pixels/inch งานสิง่พมิพเ์ทา่กบั 150-200 pixels/inch  
- Color Mode คอื โหมดสขีองภาพ ซึง่ประกอบไปดว้ย โหมดส ีBitmap, Grayscale,  

RGB Color, CMYK Color, Lab Color  
- Background Contents คอื สพีืน้หลงัของภาพ เมือ่เริม่ชิน้งานใหม ่มดีงัน้ี  
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• White กาํหนดใหส้พีืน้หลงัเป็นสขีาว  
• Background Color กาํหนดใหส้พีืน้หลงัเป็นสเีดยีวกบั Background  
• Transparent ไมม่พีืน้หลงั  

หลงัจากกาํหนดคุณสมบตัต่ิาง ๆ ใหค้ลกิปมุ่ OK เพือ่เริม่ชิน้งานใหม ่ 3. 
 

การบนัทึกข้อมลูลงบนไฟล ์(Save)  

หลงัจากตกแต่งไฟลภ์าพเรยีบรอ้ย จะตอ้งเกบ็บนัทกึขอ้มลูลงบนไฟล ์(Save) สาํหรบัการเรยีกใชง้านในครัง้ต่อไป 
โปรแกรมมกีารบนัทกึขอ้มลูลงบนไฟล ์(Save) อยู ่3 ลกัษณะ คอื  

- Save บนัทกึไฟลใ์นรปูแบบ (Format) ปกต ิซึง่จะอยูใ่นรปูแบบ (Format) ของ PSD  
- Save As บนัทกึไฟลใ์นรปูแบบ (Format) อื่น ๆ ได ้เชน่ JPEG, BMP, GIF เป็นตน้  
- Save for Web บนัทกึไฟลใ์นรปูแบบ (Format) สาํหรบัการใชง้านบนเวบ็ เชน่ ไฟล ์Html 
และไฟลร์ปูภาพ JPEG, GIF, PGN เป็นตน้  

ในทีน่ี่เป็นแสดงการใชง้านของ Save และ Save As  
1. คลกิทีเ่มนูคาํสัง่ File ทีแ่ถบ Menu bar จากนัน้เลอืกคาํสัง่ Save หรอื Save As หรอื Save 

for Web & Devices  

                 
 

2. จะปรากฏ Dialog สาํหรบักาํหนดคุณสมบตัต่ิาง ๆ ของไฟลภ์าพดงัน้ี  
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- ชือ่ไฟล ์(File Name)  
- รปูแบบของไฟล ์(Format)  
- กาํหนดคุณสมบตัขิองการบนัทกึไฟล ์(Save Options)  

• As a Copy บนัทกึไฟลเ์ป็นชือ่อื่น รปูแบบ (Format) อื่น ขณะทีไ่ฟลเ์ดมิกาํลงัเปิดใช้
งาน  

• Layers จะเกบ็คุณสมบตัขิอง Layer ต่าง ๆ  
• Use Proof setup เกบ็คา่โหมดสทีีจ่ะใชแ้สดงสขีองภาพก่อนจะพมิพ ์ 
• Thumbnail กาํหนดใหไ้ฟลท์ีบ่นัทกึ (Save) สามารถแสดงภาพตวัอยา่งใน Dialog 

ของการเปิดไฟล ์ 
• Use Lower Case Extension กาํหนดใหน้ามสกุลไฟลเ์ป็นอกัษรตวัเลก็  

หลงัจากกาํหนดคุณสมบตัต่ิาง ๆ ใหค้ลกิปมุ่ Save เพือ่บนัทกึขอ้มลูลงบนไฟล ์ 3. 

การใช้งาน Palettes  

Palettes คอื Dialog ทีใ่ชต้รวจสอบและกาํหนดคุณสมบตัต่ิาง ๆ ของรปูภาพ เชน่ Palette ของ Navigator และ 
Info, Palette ของ Color, Swatches เป็นตน้  
Palette ต่าง ๆ จะถูกจดัเป็นกลุม่ ๆ สาํหรบัการซ่อนหรอืแสดง Palettes นัน้ใหค้ลกิทีเ่มนูคาํสัง่ Window จากนัน้
เลอืก Palette ทีต่อ้งการซ่อนหรอืแสดง Palette ใดถูกเปิดใชง้านอยูจ่ะมเีครือ่งหมายถูก  
หน้า Palette   

 
 
Navigator Palette  
Navigator Palette เป็น Palette ทีใ่ชส้าํหรบัเปลีย่นขนาดมมุมอง ทีจ่อภาพตามความเหมาะสม ประกอบดว้ยสว่น
ต่าง ๆ ดงัน้ี 
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1. Proxy Preview Area คอืสว่นทีแ่สดงถงึขนาดของภาพในชิน้งาน กรอบสหีมายถงึขนาดของชิน้งาน 

หากกรอบของ Proxy Preview อยูร่มิสดุของภาพแสดงวา่ภาพนัน้มขีนาดพอดกีบัชิน้งาน  
2. ตวัเลขเปอรเ์ซน็ตข์องภาพ คอืสว่นทีใ่ชก้าํหนดขนาดมมุมองของภาพ ซึง่อยูใ่นรปูแบบของเปอรเ์ซน็ต ์

โดยคา่ของขนาดภาพจรงิจะเทา่กบั 100 เปอรเ์ซน็ต ์ 
3. Zoom Out & Zoom In คอืสว่นทีใ่ชก้าํหนดขนาดมมุมองของภาพ ประกอบดว้ยสว่นทีใ่ชก้าํหนด 3 

สว่น คอื  
3.1 Zoom Out คอืสว่นทีอ่ยูด่า้นซา้ยสดุ ใชส้าํหรบัยอ่ขนาดมมุมองของภาพใหเ้ลก็ลง  
3.2 Zoom In คอืสว่นทีอ่ยูด่า้นซา้ยสดุ ใชส้าํหรบัขยายขนาดมมุมองของภาพใหใ้หญ่ขึน้  
3.3 Zoom Slider คอืสว่นทีเ่ป็นแถบเลือ่น หากเลือ่นทางดา้นซา้ยจะยอ่ขนาดมมุมองของภาพใหเ้ลก็

ลง แต่หากเลือ่นมาทางขวาจะขยายขนาดมุมมองของภาพใหใ้หญ่ขึน้  
Color Palette  
Color Palette คอื Palette ทีท่าํหน้าทีเ่ป็นจานส ีซึง่ Mode สทีีป่รากฏในภาพจะเป็นลกัษณะการผสมใน Mode 
RGB มสีว่นประกอบต่าง ๆ ดงัน้ี  

1. Set foreground color คอืสว่นแสดงสขีอง foreground  
2. Set background color คอืสว่นแสดงสขีอง background  
3. RGB slider คอืสว่นทีใ่ชก้าํหนดคา่ของการผสมสใีน Mode RGB ซึง่สามารถเลือ่นเพือ่ปรบั

คา่สไีดจ้ากแถบ slide หรอืระบุเป็นตวัเลข (0-255) เชน่ สดีาํ คอื R=0,G=0, B=0  
4. Sample color คอืสว่นสาํหรบักาํหนดคา่สใีนลกัษณะจุม่เลอืกส ี 

 
Swatches Palette 
Swatches Palette คอื Palette ทีท่าํหน้าทีส่าํหรบัเกบ็สหีลกัๆ ทีนิ่ยมใช ้สามารถเลอืกนํามาใชไ้ดท้นัทแีละถา้หา
กวา่คุณมสีทีีต่อ้งการใชเ้ป็นประจาํ สามารถบนัทกึสนีัน้ไวใ้น Palette น้ีได ้ 



 

 
กระทรวงเทคโนโลยสีารสนเทศและการสือ่สาร   35 

 

http://www.mict4u.net 

โครงการอบรมเพ่ือการสงเสริมและพฒันาการใช ้่ ICT  
ณ ศนูยก์ารเรียนรู้ ICT ชุมชน 

การบนัทกึสทีีต่อ้งการไวท้ี ่Swatches Palette สามารถทาํไดโ้ดยเลอืกสทีีต่อ้งการ จากนัน้คลกิเมาสท์ีป่มุบนัทกึสี่

ใหมท่ี ่Swatches Palette จะสามารถบนัทกึสทีีต่อ้งการได ้ 
 

 
Styles Palette  
Styles Palette คอื Palette ทีม่ไีวส้าํหรบัเกบ็ลวดลายอยา่งลวดเรว็ สามารถเลอืกลวดลายจาก Palette น้ีไปใชใ้น
ภาพ จะทาํใหภ้าพทีคุ่ณวาดไวเ้ปลีย่นไปตามลวดลายทีเ่ลอืกไวท้นัท ีและยงัสามารถสรา้งลวดลายใหข้ึน้มาเองได้
ดว้ย  
การใชง้านนัน้สามารถทาํไดโ้ดยเลอืกที ่Layer ทีต่อ้งการจะทาํ Style แลว้คลกิเลอืกที ่Style บน Styles Palette 
จากนัน้ Layer จะเปลีย่นตาม Style นัน้ๆ 

 
History Palette  
เป็น Palette ทีแ่สดงขัน้ตอนวธิกีารต่าง ๆ ทีใ่ชท้าํงานกบัไฟลภ์าพตามลาํดบัโดยสามารถยอ้นกลบัไปยงัการ
ทาํงานต่าง ๆ ในลาํดบัชัน้และยกเลกิได ้ประกอบดว้ยสว่นต่าง ๆ ดงัน้ี  
1. สว่นทีใ่ชก้าํหนดขอ้มลูของการใช ้History Brush Tool  

เป็นภาพทีแ่สดงรายละเอยีดของงานทีท่าํตามลาํดบั  2. 
3. History State เป็นลาํดบัขัน้ตอนวธิกีารต่าง ๆ ทีไ่ดก้ระทาํลงไป 
4. New Document คอืสว่นทีใ่ชส้รา้งกระดาษทาํการใหม ่โดยคดัลอกภาพจากลาํดบัทีช่ีอ้ยู ่ 
5. New Snapshot คอืสว่นทีใ่ชส้รา้ง Snapshot ใหม ่ 
6. Trash Button คอืสว่นทีใ่ชล้บขัน้ตอนการทาํงานกบัไฟลภ์าพในลาํดบัทีเ่ลอืกอยูอ่อก 
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Layer Palette  
Layer Palette เป็น Palette ทีเ่กบ็ชิน้งานหรอืภาพทัง้หมด เรยีกวา่ Layer ซึง่จะเรยีงลาํดบัก่อนหลงั ทาํใหเ้กดิ
ความสะดวกในการจดัการแกไ้ขโดยไมเ่กดิผลกระทบกบัชิน้งานหรอืภาพอื่น ๆ โดยจะแกไ้ขเฉพาะชิน้งานหรอื
ภาพใน Layer ทีเ่ลอืกเทา่นัน้ สว่นประกอบของ Layer Palette มดีงัน้ี  

1. Indicates Layer Visibility คอืสว่นทีก่าํหนดการแสดงผลของ Layer หากมสีญัลกัษณ์รปูตาแสดงวา่
ภาพทีอ่ยูใ่น Layer ดงักลา่วถูกแสดงบน Work Area หากไมม่แีสดงวา่ Layer นัน้ถกูซ่อนหรอืไม่
แสดงผล  

2. Indicates if Layer is Linked คอืสว่นทีแ่สดงวา่ Layer ใดกาํลงัถูกทาํงาน Layer นัน้ จะมสีญัลกัษณ์
รปูพูก่นั นอกจากน้ียงัสามารถกาํหนดให ้Layer อื่นเลือ่นตาํแหน่งตาม Layer ทีก่าํลงัทาํงานอยูไ่ด้
โดยการคลกิให ้Layer อื่นเปลีย่นเป็นสญัลกัษณ์รปูโซ่  

3. Add a Layer Style คอืสว่นทีใ่ชใ้ส ่Effect เชน่ แสง เงา ต่าง ๆ ใหก้บัภาพใน Layer  
4. Add a mask คอืสว่นทีใ่ชเ้พิม่ Mask หรอืเพิม่ 1 Layer ซอ้นทบั Layer ทีก่าํลงัทาํงานอยู ่โดยทัง้ 2 

จะถอืเป็น Layer เดยีวกนั  
5. Create a new set คอืสว่นทีใ่ชส้รา้ง Folder สาํหรบัเกบ็ Layer ต่าง ๆ เขา้ดว้ยกนั  
6. Create new fill or adjustment layer คอืสว่นทีใ่ชป้รบัคา่ส ีความคมชดั แสงและความสวา่งในแบบ

ต่าง ๆ ของภาพใน Layer  
7. Create a new layer คอืสว่นทีใ่ชส้รา้ง Layer ใหม ่ 
8. Delete layer คอืสว่นทีใ่ชล้บ Layer  
9. Layer Thumbnail คอืสว่นทีแ่สดงวา่ Layer นัน้มภีาพใดอยู ่ 
10. Lock คอืสว่นทีใ่ช ้Lock ในรปูแบบต่างๆ  
11. Opacity คอืสว่นทีใ่ชท้าํให ้Layer นัน้โปรง่ใส (ทัง้ Fill และ Effect)  
12. Fill คอืสว่นทีใ่ชท้าํให ้เฉพาะ Fill ใน Layer นัน้โปรง่ใส ซึง่ไมร่วม Effect ที ่Layer นัน้มอียู ่ 
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หมายเหต:ุ แถบสน้ํีาเงนิแสดงวา่กาํลงัทาํงานกบั Layer 2  
การจดัลาํดบั Layer สามารถทาํไดโ้ดยนําเมาสค์ลกิคา้งไวท้ี ่Layer แลว้ลากไปยงัตาํแหน่งทีต่อ้งการ หรอืใชเ้มนู
คาํสัง่ Layer -> Arrange  

• Bring to Front คอื สง่ Layer ไปยงัตาํแหน่งบนสดุของทุก Layer  
• Bring Forward คอื สง่ Layer ขึน้ไปตาํแหน่งบน 1 ขัน้  
• Send Backward คอื สง่ Layer ลงไปตาํแหน่งลา่ง 1 ขัน้  
• Send to Back คอื สง่ Layer ลงไปตาํแหน่งลา่งสดุของทุก Layer แต่ยกเวน้ 

Background Layer  

การกาํหนดพืน้ท่ี เพ่ือแก้ไขและตกแตงภาพ่  (Selection)  

Marquee Tool เป็นเครือ่งมอืสาํหรบัการกาํหนด Selection โดยคลกิเลอืก Marquee Tool จาก Tool box จะม ี
ใหเ้ลอืกใชง้าน 4 รปูแบบตามความเหมาะสม 

 
 

วธีการใช้งานิ  Marquee Tool  

1. ใหค้ลกิที ่Marquee Tool บน Tool Box หรอืหากตอ้งการเลอืกรปูแบบอื่นของ Marquee Tool 
ให ้คลกิเมาสค์า้งไว ้แลว้คลกิเลอืกรปูแบบทีต่อ้งการสรา้ง Selection  

2. วางตาํแหน่ ของ Cursor รปู เพือ่กาํหนดจุดเริม่สาํหรบัการสรา้ง Selection  
3. ใหค้ลกิเมาสค์า้งไวแ้ละลากเพือ่กาํหนดขนาดของพืน้ทีท่ีต่อ้งการ แลว้ปลอ่ยเมาส ์จะปรากฏ

เสน้ประ ของ Selection ดงัภาพ  
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Marquee options  
เมือ่คลกิเลอืกใชง้าน Marquee Tool ที ่Tool options bar เราจะสามารถกาํหนดคุณสมบตัต่ิาง ๆ ของ Marquee 
tool ไดด้งัน้ี  
 

 
 

1. การแกไ้ข Selection จะมใีหเ้ลอืก 4 รปูแบบคอืการกาํหนดเลอืก Selection ใหม ่การเพิม่ ตดัและลด 
Selection และการสรา้ง Selection ดว้ยวธิกีารต่างๆ ดงัน้ี  

เมือ่คลกิเมาสจ์ะเป็นการสรา้ง Selection ขึน้ใหม ่ 
สรา้ง Selection เพิม่ขึน้ โดยพืน้ที ่Selection ก่อนหน้าจะไมห่ายไป แต่จะถูกรวมเขา้ดว้ยกนั  
ลบพืน้ทีข่อง Selection ออกจาก Selection ก่อนหน้า  
เป็นการสรา้ง Selection ใหมใ่นพืน้ที ่Selection เดมิ ดว้ยวธิ ีIntersect จากพืน้ที ่Selection ทีก่าํหนด ใหมแ่ละ 
Selection ก่อนหน้า ทีม่พีืน้ทีเ่ดยีวกนั  

2. Feather กาํหนดความฟุงเบลอของขอบ้  Selection ภาพ มคีา่ตัง้แต่ 1 – 250 หากกาํหนดคา่มากความฟุง้  
เบลอจะมากตาม  

3. Style ของ Marquee Options ม ี3 รปูแบบคอื  

•  Normal เลอืกขนาดอสิระ ขนาดของ Selection จะเปลีย่นไปตามการเคลือ่นตาํแหน่งเมาส ์ 

• Constrained Aspect Ratio กาํหนดขนาดของ Selection โดยยดืหยุน่ตามอตัราสว่นของความ กวา้ง 
(Width) และความสงู (Height)  

• Fixed Size กาํหนดขนาดของ Selection ตามอตัราสว่นของความกวา้ง (Width) และความสงู (Height) 
ทีแ่น่นอน  

4. Width การกาํหนดความกวา้งของ Selection  
5. Height การกาํหนดความสงูของ Selection  
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18การสร้าง Fixed Size Selection  

ถา้ตอ้งการสรา้ง Selection ขนาดกวา้ง 600 ยาว 80 Pixels ใหเ้ปลีย่นชอ่ง Style เป็นแบบ Fixed Size และ
กาํหนดความกวา้งและความยาวตามทีต่อ้งการ  

 

Lasso Tool  

เป็นเครือ่งมอืทีส่ามารถสรา้ง Selection ไดอ้ยา่งอสิระ มคีวามยดืหยุน่สงู เมือ่คลกิ Lasso Tool ที ่Tool bar จะมี

ใหเ้ลอืกทัง้หมด 3 รปูแบบดงัน้ี  
1. Lasso Tool  
เป็นการสรา้ง Selection อยา่งอสิระ วธิกีารใชง้านเมือ่คลกิเมาสค์า้งแลว้ลากไปตามขอบของพืน้ที ่Selection ที่
ตอ้งการ จนมาบรรจบทีจุ่ดเริม่ตน้แลว้จงึปลอ่ยเมาสจ์ะปรากฏเสน้ประของ Selection สามารถ กาํหนดคุณสมบตัิ
ของ Lasso Tool ต่าง ๆ ไดด้งัน้ี  

 
• Feather กาํหนดความฟุงเบลอของขอบพืน้ที่้  Selection  
• Anti-aliased กาํหนดใหข้อบของพืน้ทีท่ีเ่ลอืกมคีวามเรยีบยิง่ขึน้ ไมข่รุขระ  

2. Polygonal Lasso Tool  
เป็นการสรา้งพืน้ทีข่อง Selection ในลกัษณะของรปูหลายเหลีย่ม คลกิเมาสบ์นภาพเพือ่กาํหนด จุดเริม่ตน้ในครัง้
แรกแลว้ ลากเมาสจ์ะปรากฏเสน้ต่อจากจุดเริม่ตน้กบัปลายเมาส ์วธิกีารใชง้านเมือ่คลกิเมาส ์

Selection ทีเ่ป็นเสน้ตรงเชือ่มจากจุดตน้มายงัจุดปลายเมาสท์ีค่ลกิ ใหท้าํแบบน้ีเรือ่ย ๆ เพือ่สรา้งเสน้
ขอบของ Selection จนสดุทา้ยใหค้ลกิเมาสบ์รรจบทีจุ่ดเริม่ตน้ครัง้แรก จะเกดิ Selection ขึน้ สาํหรบัการกาํหนด
คุณสมบตัจิะเหมอืนกบั Lasso Tool  

3. Magnetic Lasso Tool  
เป็นการสรา้งพืน้ทีข่อง Selection อยา่งอสิระและรวดเรว็ในลกัษณะของแมเ่หลก็ทีด่ดูเขา้หาส ีโดย 

Magnetic Lasso Tool จะใชค้วามแตกต่างระหวา่งสทีีเ่ลอืกกบัสขีอง Background เป็นตวักาํหนดขอบเขต พืน้ที ่
Selection วธิกีารใชง้านเมือ่คลกิเมาสเ์พือ่กาํหนดจุดเริม่ตน้แลว้ ใหป้ลอ่ยเมาสแ์ลว้ลากเมาสต์าม ขอบเขตพืน้ทีท่ี่
ตอ้งการเลอืก Magnetic Lasso Tool จะเลอืกขอบเขตพืน้ที ่Selection เองโดยอตัโนมตั ิจน สดุทา้ยใหค้ลกิเมาส์
บรรจบทีจุ่ดเริม่ตน้ครัง้แรก จะเกดิ Selection ขึน้ คุณสมบตัขิอง Magnetic Lasso Tool มเีพิม่จาก Lasso Tool 
ไดด้งัน้ี 
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1. W 0 pixels เป็นการกาํหนดใหโ้ปรแกรมทาํการตรวจสอบหาขอบเขตของพืน้ทีท่ี่

2. E ทีเ่ลอืกอยูร่ะหวา่งสทีี ่
กนัมาก  
 มคีา่ตัง้แต่ 0-100 pixels หากคา่ความถีม่ากจะทาํใหม้กีารกาํหนดจุดในแต่ละชว่งของการ 

กาํหนดพืน้ทีข่อง Selection โดยเลอืกบรเิวณทีม่คีา่สใีกลเ้คยีงกนั วธิกีารใชง้านคอืคลกิทีป่มุ่

idth มคีา่ตัง้แต่ 1-4
เลอืก นบัตัง้แต่จุดทีเ่มาสช์ีอ้ยูไ่ป X pixels เพือ่กาํหนดขอบเขต  
dge Contrast มคีา่ตัง้แต่ 0-100% หากมคีา่มากจะทาํใหเ้สน้ขอบของพืน้ที่
Contrast 

3. Frequency
เลอืกมาก ทาํใหโ้ปรแกรมสามารถเลอืกพืน้ทีอ่ยา่งมคีวามถูกตอ้งมากขึน้  

Magic Wand Tool  

 บน 
Tool box แลว้คลกิเลอืกพืน้ทีท่ีต่อ้งการสรา้ง Selection นอกจากน้ีแลว้ยงัสามารถกาํหนดคุณสมบตัขิอง Magic 
Wand Tool ไดด้งัน้ี 

 
1. ีใ่กลเ้คยีงกบัสทีีถู่กเลอืก  

3. เ้คยีงกนัไดเ้ฉพาะในกลุม่ pixels ทีไ่ดค้ลกิเลอืกเทา่นัน้ 
ไ่ด ้Check ไวจ้ะเลอืกบรเิวณทีม่สีใีกลเ้คยีงกนัในภาพทัง้หมด  

All Layers เลอืกสโีดยมองทุก Layer เป็นเหมอืน Layer เดยีว หากไมถู่ก Check ไว ้หมายถงึใช ้

tion ในภาพทิง้ไป วธิกีารใชง้านคอื

คลกิทีป่มุ่

Tolerance มคีา่ใหก้าํหนดตัง้แต่ 0 – 255 pixels เป็นคา่ของจาํนวนสที
2. Anti-aliased กาํหนดใหข้อบของพืน้ทีท่ีเ่ลอืกมคีวามเรยีบยิง่ขึน้ ไมข่รุขระ  

Contiguous สามารถทาํการเลอืกบรเิวณสทีีใ่กล
ถา้ ไม

4. Use 
Magic Wand Tool เฉพาะ Layer นัน้เทา่นัน้  

Crop Tool  

กาํหนดพืน้ทีข่อง Selection โดยตดัสว่นทีเ่หลอืทีไ่มไ่ดอ้ยูใ่นพืน้ทีข่อง Selec

  

 ์เมื่

บน Tool box แลว้คลกิเมาสค์า้งไวจ้ากนัน้ลากเมาสเ์พือ่กาํหนดพืน้ทีข่อง Selection แลว้จงึ

ปลอ่ยเมาส อพรอ้มทีจ่ะตดัสว่นทีเ่หลอืออก ใหค้ลกิ ปมุ่  บน Tool options bar หรอื ปมุ่ เพือ่
ยกเลกิ นอกจากน้ีเรายงัสามารถกาํหนดคุณสมบตัต่ิาง ๆ ของการตดั ดงัน้ี  

 
1

ก  

ีจ่ะถกูตดัออก  

. Cropped Area เลอืกผลลพัธข์องภาพทีต่ดั  
• Delete ตดัภาพโดยลบสว่นทีเ่หลอืออ
• Hide ตดัภาพ โดยซ่อนสว่นทีเ่หลอืเอาไว ้ 

2. Shield cropped area แสดงสบีนพืน้ทีส่ว่นทีเ่หลอืท
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3. Color สทีีจ่ะแสดงบนพืน้ทีส่ว่นทีเ่หลอื  
4. Opacity คา่ความโปรง่แสงของสบีนพืน้ทีส่ว่นทีเ่หลอื  
5. Perspective ปรบัพืน้ทีก่ารตดัใหไ้ดภ้าพทีม่มีติ ิ 

ฐานของ Selection  คาํสัง่พืน้

 

 

• All กาํหนดพืน้ที ่Selection โดยใชพ้ืน้ทีข่องรปูภาพ

  
 

การใช้ Transform เพ่ือปรบัเปล่ีย

คลกิทีเ่มนูคาํสัง่ Edit ทีแ่ถบ Menu ba   
น้ี 1 ขัน้  

  

ารมองแบบ 
กึ)  

ม็นาฬกิา  
Rotate 90? CCW หมนุ 90 องศาทวนเขม็นาฬกิา  

ลบัจากซา้ยเป็นขวา  

 

การใช้งาน Foreground และ Background Color  

การใชง้านในสว่นของ Foreground และ Background Color สามารถทาํไดท้ีส่ว่นของ Toolbox ดงัรปู  

าํหนดพืน้ที ่Selection หลงัจากได้
กิไป  

• Inverse เป็นการเปลีย่นพืน้ทีข่อง Selection จากทีก่าํหนด

ทัง้หมด  
• Deselect ยกเลกิการกาํหนดพืน้ที ่Selection  

Reselect ยอ้นกลบัไปก• 
ยกเล

ไวใ้หเ้ป็น พืน้ทีต่รงขา้ม  

นพืน้ท่ี Selection  

r จากนัน้เลอืกคาํสัง่ Transform
- Again กลบัสูร่ปูแบบเดมิก่อนหน้า
- Scale ปรบัเปลีย่นแบบ Scale ตามแนวตัง้ แนวนอนและแนวทแยง
- Rotate หมนุพืน้ทีท่ีเ่ลอืก  
- Skew ปิดเกลยีวพืน้ทีเ่ลอืก  
- Distort การบดิเบอืนพืน้ทีเ่ลอืก  
- Perspective ปรบัขนาดของพืน้ทีเ่ลอืกใหม้ลีกัษณะก

าว ความลPerspective (แบบมมีติ ิความกวา้ง ความย
- Rotate 180? CW หมนุ 180 องศา  

Rotate 90? CW หมนุ 90 องศาตามเข- 
- 
- Flip Horizontal ก
- Flip Vertical กลบัจากบนลงลา่ง  
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สามารถเปลีย่นสไีดโ้ดยคลกิทีก่รอบ Foreground หรอื Background จะปรากฏ Color Picker ใหเ้ปลีย่นส ี 

 

การใช้งาน Type Tool 

สามารถสร้างขอ้ความไดท้งัในแนวนอนและแนวตงั้ ้  การสร้างขอ้คว ตล่ามแ ะครังโปรแกรม้  Adobe 
Photoshop จะสร้าง Layer ใหมอตัโนมติั่  ลกัษณะของขอ้ความจะมี 2 รูปแบบคือ 

1. แบบ Point Type จะมีรูปแบบเป็นคาํหรืออกัษรสนั้  ๆ 1 บรรทดั โดยกาหนดจุดเริมตน้ของํ ่

ขอ้ความบนชินงาน้  โปรแกรมจะสร้าง Type Layer ขึนมา้  และสามารถพิมพข์อ้ความลงไปได ้
เม่ือพิมพข์อ้ความเรียบร้อย ใหค้ลิกท่ีปุ่ม  เพื่อตกลง หรือคลิกปุ่ม  

2. แบบ Paragraph Type จะมีรูปแบบเป็นขอ้ความท่ีมีหลายบรรทดั โดยจะอยภูายในขอบเขต่

ท่ีกาหนดเดียวกนํ ั  (Bounding box) โดยกาหนดจุดขอบเขตของขอ้ความท่ีใสํ ่ โปรแกรมจะสร้าง Type 
Layer ขึนมา้  และสามารถพิมพข์อ้ความและจดัเป็น Paragraph ไดจ้าก Paragraph Palette 
เม่ือพิมพข์อ้ความเรียบร้อย ใหค้ลิกท่ีปุ่ม  เพื่อตกลง หรือคลิกปุ่ม  

 
หากตอ้งการแกไ้ขขอ้ความทีพ่มิพใ์หค้ลกิทีป่มุ่  แลว้ลากเมาสบ์นขอ้ความทีต่อ้งการแกไ้ขใหเ้กดิ

แถบส ีแลว้ จงึปรบัแกไ้ขขอ้ความ หรอืเปลีย่นแปลงคุณสมบตัต่ิาง ๆ ของขอ้ความบน Tool options bar เมือ่

แกไ้ขเรยีบรอ้ยแลว้จงึ คลกิปมุ่  
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หากตอ้งการตวัอกัษรทีม่ลีวดลายของภาพ Background เชน่ สามารถ
ทาํไดโ้ดยใชส้รา้ง Selection ของตวัอกัษร ซึง่มวีธิใีหค้ลกิทีป่มุ่ เพือ่เลอืก Horizontal Type Mask Tool หรอื 
Vertical Type Mask Tool แลว้พมิพข์อ้ความทีช่ิน้งาน เมือ่พมิพเ์สรจ็ จะเกดิ Selection ทีเ่ป็นตวัอกัษร จากนัน้ 
สามารถทีจ่ะคดัลอกลวดลายภาพทีต่อ้งการตาม Selection ของขอ้ความนัน้ได ้

 
Warp Text เม่ือคลิกปุ่ม จะปรากฏ Dialog สาํหรับกาหนดคาเพ่ือปรับแตงรูปทรงของขอ้ความํ ่ ่  

 
 

ตวัอย่าง Warp Text 
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26การใช้งา

น่ใสวางซอ้นกนัเป็นลาํดบัของรปูภาพ ชว่ยแยกการทาํงาน
ให ้ชดัเจน โดยการทาํงานแต่ละครัง้จะมผีลกบั Layer ทีเ่ลอืกอยูเ่ทา่นัน้ การมองจะอยูใ่นลกัษณะมองจากดา้นบน
ลงมา ดา้นลา่ง วธิกีารเรยีกใชง้าน Layer คลกิทีเ่มนูคาํสัง่ Window ทีแ่ถบ Menu bar เลอืกคาํสัง่ Show Layer 
ถา้หากพบวา่ Hide Layers แสดงวา่ Palette Layer ถูกแสดงแลว้ 

Active Layer คอื Layer ทีก่าํลงัถูกทาํงานอยู ่สามารถเลอืก Layer ไดจ้ากการคลกิทีแ่ถบ Layer จากนัน้
ชอ่ง Indicates if Layer is จะมสีญัลกัษณ์รปูพูก่นัปรากฏ หากตอ้งการเคลือ่นยา้ย Layer โดยให ้Layer อื่น
เคลือ่นยา้ยตาม ใหค้ลกิทีช่อ่ง Indicates if Layer is ใหเ้ป็นรปูโซ ือ่เชือ่ม Layer เขา้ดว้ยกนั  

ทีช่อ่ง Indicates Layer Visibility หากปรากฏสญัลกัษณ์รปูตาหมายความวา่ Layer นัน้ถูกแสดงอยู ่
หาก ต ไมใ่หแ้สดงผล ใหค้ลกิทีช่อ่ง Indicates Layer Visibility สญัลกัษณ์รปูตาจะหายไป 

น Layer  

ลกัษณะการทาํงานของ Layer เป็นเหมอืนแผ

่เพ
การเปลีย่นลาํดบัของ Layer สามารถทาํไดโ้ดยคลกิเมาสท์ี ่Layer คา้งไวแ้ลว้ลากไปยงัลาํดบัของ 

Layer ที ่ตอ้งการแลว้ปลอ่ยเมาส ์ 

อ้งการซ่อน Layer 

 
การสรา้ง Layer ขึน้ใหม ่ใหค้ลกิทีป่มุ่ หากตอ้งการคดัลอก Layer ใหค้ลกิ Laye ทีต่อ้งการแลว้ปลอ่ย 

งทีป่มุน้ีเชน่เดยีวกนั่  แต่ถา้ตอ้งการลบ Layer หลงัจากคลกิเลอืก Layer ทีต่อ้งการแลว้ใหค้ลกิทีป่มุ่  

รอืตกแต่งภาพบน Layer  

า้มโดยใชก้ารกาํหนดคุณสมบตัขิองทัง้ 3 ขอ้ทีก่ลา่วมา  

r 
ล

 
การ Lock Layer  
 
เป็นการกาํหนดคุณสมบตัต่ิาง ๆ เพือ่บงัคบัไมใ่ห ้Layer ถูกเปลีย่นแปลงหรอืไดร้บัผลกระทบใด ๆ ม ี

ทัง้หมด 4 รปูแบบดงัน้ี  
1. Lock transparent pixels หา้มไมใ่หเ้ตมิสหีรอืปรบัแกส้ลีงไปใน pixels ทีโ่ปรง่แสงบน Layer ได ้ 
2. Lock image pixels หา้มไมใ่หม้กีารแกไ้ขห
3. Lock position หา้มไมใ่หม้กีารเคลือ่นยา้ยตาํแหน่งของ Layer  
4. Lock all ห

 



 

 
กระทรวงเทคโนโลยสีารสนเทศและการสือ่สาร   46 

 

http://www.mict4u.net 

โครงการอบรมเพ่ือการสงเสริมและพฒันาการใช ้่ ICT  
ณ ศนูยก์ารเรียนรู้ ICT ชุมชน 

การ Merge Layer  
เป็นการรวมชัน้ของ Layer ตัง้แต่ 2 ชัน้ขึน้ไปมาไวร้วมกนั โดยคลกิทีป่มุ่ แลว้จะปรากฏ Dialog 

สาํหรบัเลอืกแบบต่าง ๆ ของการ Merge Layer ดงัน้ี 

 
- Merge Down หรอื Merge Linked เป็นการรวม Layer ทีใ่ชง้านอยูก่บั Layer ทีอ่ยูล่าํดบัถดัลง โดยถา้ Layer 

ปูโซ่ จะมขีอ้ความวา่ Merge Linked แต่หากไมม่รีปูโซ่จะมขีอ้ความวา่ Merge 
Down  

แสดงหรอืมองเหน็ไดท้ัง้หมด  
- 

ckground และจะลบ Layer ทีถู่กซ่อน ทิง้ไป  
ากตอ้งการเปลีย่นชือ่ของ Layer ใหค้ลกิเลอืก Layer Properties จะปรากฏ Dialog ของ Layer ซึง่ สามารถ

เปลีย่นชือ่ของ Layer ได ้และแถบสไีด ้ 

ทีอ่ยูล่าํดบัถดัไปมสีญัลกัษณ์ ร

- Merge Visible  
เป็นการรวม Layer ทีถู่ก

Flatten Image  
เป็นการรวม Layer ทุกลาํดบัชัน้เป็น Layer เดยีว โดยมชีือ่วา่ Ba
ห

 
 
 

การจดั Set ของ Layer  
เป็นการรวบรวม Layer ต่าง ๆ มาไวเ้ป็นกลุ่ม Layer Set สามารถใชค้าํสัง่ต่าง ๆ เหมอืน Layer ทัว่ 

ไป เชน่ การด ูคดัลอก เคลือ่นยา้ย และการเปลีย่นลาํดบั ยกเวน้คาํสัง่บางคาํสัง่ เชน่ Layer Effect ดงันัน้ใช ้งาน
คาํสัง่ใด ๆ ของ Layer Set จะเกดิขึน้กบั Layer ภายในทุก Layer  

การสรา้ง Layer Set คลกิทีป่มุ่  เพือ่สรา้ง Set หลงัจากนัน้ใหค้ลกิเลอืก Layer ทีต่อ้งการ จดัเกบ็
คา้งไว ้แลว้ลากที ่Layer Set จากนัน้ใหป้ลอ่ยเมาส ์ 
 
หากดบัเบิล้คลกิที ่Layer Set จะปรากฏ Dialog ของ Layer Set Properties ซึง่สามารถเปลีย่นชือ่ของ Layer  
Set ได ้และแถบสไีด ้
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การทาํภาพโดยใช้ Filter  

ฟิลเตอร ์(Filter) คอืการตกแต่งภาพดว้ยเทคนิคพเิศษ ทีส่ามารถปรบัเปลีย่นรปูแบบของภาพตามความ
ตอ้งการของงาน เราสามารถใชง้าน Filter ไดโ้ดยเลอืก Menu > Filter > เลอืกใช ้Filter ทีต่อ้งการ  
ตวัอยางการใช้่  Filter  

ที ่Menu Bar จะมปีมุ่ Filter(1) อยู ่เมือ่กดแลว้จะม ีFilter Menu ปรากฏขึน้เลือ่นเมาสไ์ปยงั Filter 
“Blur”(2) จะมเีมนูยอ่ยเพิม่ขึน้มา ใหก้ดเลอืกที ่“Redial Blur”(3) 
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เมือ่เลอืกเสรจ็แลว้จะปรากฏหน้าจอการปรบัเปลีย่นลกัษณะของ Filter สามารถทีจ่ะกําหนดไดต้าม
ตอ้งการ (ใน Filter แต่ละตวันัน้ หน้าจอการปรบัเปลีย่นลกัษณะของ Filter จะไมเ่หมอืนกนั) เสรจ็แลว้กดปมุ่ OK 
เพือ่จบขัน้ตอนการทาํงานของ Filter 

 
 
จะไดภ้าพทีม่กีารตกแต่งดว้ย Filter: Radial Blur ออกมา ทัง้น้ี ถา้ใช ้Filter อื่นรปูงานทีป่รากฏ จะต่างกนัออกไป 

 
ตวัอยาง่  Filter ท่ีนาสนใจ่  



 

 
กระทรวงเทคโนโลยสีารสนเทศและการสือ่สาร   49 

 

http://www.mict4u.net 

โครงการอบรมเพ่ือการสงเสริมและพฒันาการใช ้่ ICT  
ณ ศนูยก์ารเรียนรู้ ICT ชุมชน 
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การใช้งาน Layer Style  

คลกิทีเ่มนู Layer > Layer Style > Blending Options จะปรากฏหน้าต่างดงัภาพขา้งลา่ง 
 

 
 

 (1) คอื Style ทีต่อ้งการใชก้บั Layer ทีเ่ราเลอืกไว ้จะมใีหเ้ลอืก 10 แบบจากบนลงลา่ง  
 (2) คอื การกาํหนดคา่ต่างๆ ของแต่ละ Style ซึง่จะแตกต่างกนัไปในแต่ละ Style  

ตวัอยางการใช้่  Layer Style 
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การเปล่ียนรปูรางของรปู่  (Transform)  

ลีย่นแปลง Layer ในรปูแบบต่างๆไดเ้ชน่ การยอ่/ขยาย การหมนุภาพ การบดิภาพ ดว้ย
คาํสัง่ Transform 
 
ลกัษณะของ Transform 

เราสามารถเป
โดยคลกิเลอืก Edit > Transform > (เลือก Transform Function ท่ีต้องการ)  

 
 

การป ss/Contrast)  

การปรบัความสวา่ง-ความมดืของภาพ และการตดักนัของสทีีช่ดัเจนขึน้นัน้ สามารถทาํไดโ้ดยใชค้าํสัง่ 
trast โดยเลอืกคลกิที ่Image > Adjust > Brightness/Contrast 

 

รบัคาความสวาง่ ่ /ความคมชดั (Brightne

Brightness/Con
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การปรบัขนาดของชนงานิ้   

Image Size  
Image Size คอืการ ลด/ ขยายรปูภาพโดยสามารถใชค้าํสัง่น้ีไดจ้ากเมนู Image > Image 

้าต่างทีใ่หเ้รากาํหนดขนาดของภาพขึน้มาดงัรปู Size… จะปรากฏหน

 
 

(1) Width(กวา้ง) และ Height(สงู) ของรปูภาพ สามารถกาํหนดไดต้ามตอ้งการ โดยมหีน่วยให้
เลอืกสองแบบคอื Pixel และ %  

Proportions Sign เมือ่สญัลกัษณ์น้ีปรากฏดงัรปู แสดงวา่เมือ่เราไดก้าํหนด(2) Constrain 
ขนาดภาพไวด้า้นใดดา้นหน่ึงแลว้ โปรแกรมจะกาํหนดสดัสว่นของดา้นทีเ่หลอืใหเ้อง(อตัราสว่นทีเ่ทา่กนั) 
ผลทีไ่ดก้ค็อื ไมว่า่จะยอ่หรอืขยาย รปูภาพทีอ่อกมากจ็ะมอีตัราสว่นของ กวา้ง x สงูเทา่เดมิ  

(3) Constrain Proportions Check Box จาก (2) เมือ่เราไมต่อ้งการ ยอ่/ขยาย รปูภาพให้

เหมอืนอตัราสว่นเดมิใหค้ลกิที ่Check Box ออก เครือ่งหมาย จ
ก

ะหายไปหลงัจากนัน้การกาํหนดขนาด 

 
Canvas

ีร่ปู โดยเพิม่พืน้ Background และสามารถขยายรปูโดย

วา้งและสงูสามารถกาํหนดไดต้ามตอ้งการ  

 Size  
การ Canvas Size คอืการลด/ ขยายพืน้ท

กาํหนดทศิทางได ้ดงัรปู 

 
1. Current Size ขนาดปจจุบนัของงานั   
2. New Size ขนาดทีเ่พิม่ขึน้จากขนาดของงาน  
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3. Relative เป็นคุณสมบตับิอกคา่ขนาดของ New Size เครือ่งหมาย คา่ในชอ่ง Width และ Height จะเป็น 0 
สามารถเพิม่พืน้ทีง่านโดยไมต่อ้งรวมคา่ Current Size  
4. Anchor ทีท่างทีต่อ้งการเพิม่ขนาดใหไ้ปในทศิทางทีต่อ้งการ 
 
ตวัอยางการ่  Canvas Size 

 

การตดักรอบของรปู (Crop)  

การ Crop คอื การตดักรอบภาพเอาเฉพาะทีต่อ้งการ นอกจากรปูภาพจะมขีนาดเลก็เกนิไปแลว้ บางครัง้
รปูภาพกม็ขีนาดใหญ่เกนิไปไดเ้ชน่กนั เราสามารถตดักรอบภาพ (Cropping) ใหเ้หลอืเฉพาะทีต่อ้งการไดโ้ดยใช้
เครือ่งมอืสองชนิดน้ี ดงัน้ี  
วธีท่ีิ  1 การตดักรอบภาพโดยเครื่องมือ Rectangular Marquee Tool  

1. เลอืกเครือ่งมอื บนแถบเครือ่งมอืและกาํหนด Feather ใหเ้ทา่กบั 0 ก่อน  
2. สรา้ง Selection ทีภ่าพในสว่นทีต่อ้งการตดักรอบ  
3. เลอืกเมนู Image -> Crop จะไดร้ปูจากการ Cropping  

วธีท่ีิ  2 การตดักรอบภาพโดยเครื่องมือ Crop  
1. เลอืกเครือ่งมอื บนแถบเครือ่งมอื  
2. สรา้งพืน้ทีท่ีต่อ้งการตดักรอบภาพ สงัเกตวา่จะเกดิแถบสเีทาขึน้บรเิวณรอบนอกขอบกรอบทีส่รา้ง

ขึน้มา บรเิวณสเีทาคอื บรเิวณของรปูภาพทีถู่กตดัทิง้นัน่เอง  
3. ปรบัแต่งพืน้ทีท่ีเ่ลอืก  
4. คลกิปมุ่ เพือ่ยนืยนัการตดักรอบรปูตามตอ้งการ (กรณยีกเลกิใหค้ลกิปมุ่ แทน)  
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 ตวัอย่างการ Cropping
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ตอนท่ี 3 เทคนคการสร้างิ  และออกแบบ Website ด้วย 

Adobe Dreamweaver CS3 
 

ือ่งมอืสาํหรบัสรา้งเวบ็เพจ และ ดแูลเวบ็ไซต ์ทีม่ปีระสทิธภิาพสงู เป็นที่
นิยมใชข้อ

กั 
ส้ะดวกย ึน้  

ความสา
ในการเข พมิพง์านในโปรแกรม Text Editor ทัว่ไป คอืวา่มนัจะเรยีง

ชดิซา้ยบนตลอดเวลา ไมส่ามารถยา้ย หรอื นําไปวางตาํแหน่งทีต่อ้งการไดท้นัทีเ่หมอืนโปรแกรมกราฟิก 
เพราะฉะนัน้หากเราตอ้งการจดัวางรปูแบบตามทีเ่ราตอ้งการ กใ็ชต้าราง Table เขา้มาชว่ยจดัตําแหน่ง ซึง่เมือ่มี
การจดัวางรปูแบบทีซ่บัซอ้นมากขึน้ การเขยีนภาษา HTML กซ็บัซอ้นยิง่ขึน้เชน่กนั โปรแกรม Dreamweaver 
อาจจะไมส่ามารถเขยีนเวบ็ไดต้ามทีเ่ราตอ้งการทัง้หมด วธิกีารแกไ้ขปญหาทีด่ทีีส่ดุคอืั  ควรจะเรยีนรูห้ลกัการของ
ภาษา HTML ไปดว้ย ซึง่ถอืวา่เป็นสิง่ทีจ่าํเป็นมากสาํหรบัผูท้ีต่อ้งการประกอบอาชพี Webmaster แบบจรงิจงั 
อาจจะไมต่อ้งถงึกบัทอ่งจาํ Tag ต่าง ๆ ไดท้ัง้หมด แต่ขอใหรู้ ้เขา้ใจหลกัการกพ็อแลว้ เพราะหลาย ๆ ครัง้ทีเ่ราจะ
เขยีนเวบ็ใน Dreamweaver แลว้กลบัไดผ้ลผดิเพีย้นไป ไมต่รงตามทีต่อ้งการ กต็อ้งมาแกไ้ข Code HTML เอง 
และความสามารถของ Dreamweaver สรุปไดด้งัน้ี  

1. สนบัสนุนการทาํงานแบบ WYSIWYG (What You See Is What You Get) หมายความวา่ เวบ็ทีเ่รา
ยีนหน้าจอ Dreamweaver กจ็ะแสดงแบบเดยีวกบัเวบ็เพจจรงิๆ ชว่ยใหเ้ราเขยีนเวบ็เพจงา่ยขึน้ ไมต่อ้งเขยีน 

Code HTML เอง  
2. มเีครือ่งมอืในการชว่ยสรา้งเวบ็เพจ ทีม่คีวามยดืหยุน่สงู  
3. สนบัสนุนภาษาสครปิตต่์างๆ ทัง้ฝง่ั Client และ Server เชน่ Java, ASP, PHP, CGI, VBScript  
4. มเีครือ่งมอืในการ Upload หน้าเวบ็เพจไปทีเ่ครือ่ง Server เพือ่ทาํการเผยแพรง่านทีเ่ราสรา้งใน

อนิเทอรเ์น็ต โดยการสง่ผา่น FTP หรอื โดยการใชโ้ปรแกรม FTP ภายนอกชว่ย เชน่ WS FTP  
5. รองรบัมลัตมิเีดยี เชน่ การใสเ่สยีง, การแทรกไฟลว์ดิโีอ, การใชง้านรว่มกบัโปรแกรม Flash, Fireworks  

 
การใช้งานพืน้ฐาน (สงท่ีควรทราบเบือ้งต้นิ่ )  

1. ภาษา HTML เป็นภาษาทีอ่อกแบบสาํหรบัการแสดงผลเทา่นัน้! ไมส่ามารถประมวลผล หรอื ใช้
เขยีนเวบ็แอพพลเิคชัน่ได ้ 

2. หากตอ้งการเพิม่ลกูเลน่ หรอื เทคนิคพเิศษ เชน่ Effect ต่าง ๆ ตอ้งนําภาษา JavaScript าเสรมิ 
TML อกีท ี3. การจดัรปูแบบใน Code เชน่การขึน้บรรทดัใหม ่การเวน้วรรค ไมม่ผีลต่อการแสดงผลทาง Web 

Browser  

รู้จกักบั Dreamweaver  
Dreamweaver ถอืไดว้า่เป็นเคร
ง Web Master อยา่งกวา้งขวาง ซึง่เป็นโปรแกรมสาํหรบัเขยีนภาษา HTML โดยเฉพาะ พรอ้มทัง้

สามารถแทรก Java Scripts และ ลกูเลน่ต่างๆไดม้ากมาย โดยทีผู่ใ้ชไ้มจ่าํเป็นตอ้งรูห้ลกัภาษา HTML มากน
ซึง่ชว่ยประหยดัเวลา และ ทาํงานได ิง่ข

มารถของ Dreamweaver  
ยีนเวบ็เพจ จะมลีกัษณะคลา้ยกบัการ

เข

ม
H
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4. การขึน้บรรทดัใหม ่ตอ้งใช ้Tag <BR> หรอื กดปมุ่ Shift+Enter 5. การขึน้ยอ่หน้าใหม ่ตอ้งใช ้Tag 
<P> หรอื กด trl+ Shift + Spacebar 7. 
หลกัการอ่าน . ไฟล ์HTML และ Script ต่างๆ 
สามารถเปิดแ

9. การ ข์อ้ความตาม
ตอ้งการ หรอื คา่ต่าง ๆ เพิม่เตมิ  

การเรมต้นิ่

หลงัจา
ต่อไปน้ี  

1. 

ปมุ่ Enter 6. การเวน้วรรค ตอ้งใช ้Tag พเิศษ คอื &nbsp; หรอื กดปมุ่ C
 Tag ของภาษา HTML จะอ่านคา่จาก Tag ทีอ่ยูด่า้นในก่อน 8
กไ้ขในโปรแกรม Text Editor ทัว่ ๆ ไป ไมจ่าํเป็นตอ้งแกไ้ขใน Dreamweaver เพยีงอยา่งเดยีว  

แทรกขอ้ความ และ การปรบัแต่งคา่ต่าง ๆ ใหค้ลกิตาํแหน่งทีต่อ้งการ แลว้พมิพ
ใหเ้ลอืกขอ้ความเมือ่ตอ้งการกาํหนด

ใช้งาน Dreamweaver  

กทีท่าํการตดิตัง้ Dreamweaver เรยีบรอ้ยแลว้ กส็ามารถเรยีกใชง้านโปรแกรมดว้ยวธิกีาร

Click Mouse ทีป่มุ่  
กคาํสัง่ All Program > เลอืกตามรปู  2. เลอื
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สวนประกอบของ่

• แถบคาํสัง่ (Menu Bar) เป็นแถบทีใ่ชเ้กบ็คาํสัง่ทัง้หมดของโปรแกรม  

• แถบวตัถุ (Object Palette) เป็นกลุม่เครือ่งมอืต่างๆ ทีใ่ชใ้นการควบคุมวตัถุ บนชิน้งาน เอกสาร
เวบ็ เชน่ เสน้กราฟิก (Horizontal Rule), ตาราง, รปูภาพ, เลเยอร ์(Layer)  

• แถบแสดงสถานะ (Status Bar)  
• แถบควบคุมการทาํงาน (Properties Palette) เป็นรายการทีป่รบัเปลีย่นได ้ตามลกัษณะการเลอืก

ขอ้มลู เชน่ หากมกีารเลอืกทีจ่ะพมิพ ์หรอืแกไ้ขเน้ือหา รายการกจ็ะเป็น สว่นทาํงานทีเ่กีย่วกบั
อกัษร, การจดัพารากราฟ ถา้เลอืกทีร่ปูภาพ รายการในแถบน้ี กจ็ะเป็นคาํสัง่ต่างๆ ทีเ่กีย่วกบั 
การควบคุมเรือ่งรปูภาพ  

• สว่นของ Panel Group เป็นกลุม่ของแถบเครือ่งมอืทีส่ามารถเรยีกใชง้านไดอ้ยา่งรวดเรว็ เพือ่ให้
งา่ยในการสรา้ง Application บนอนิเทอรเ์น็ต เชน่ การแทรก Code ของ JavaScript และ 
VBScript ลงในเวบ็เพจไดอ้ยา่งงา่ยๆ โดยสามารถเรยีกใชง้านไดจ้าก Panel Group  

 

weaver 

 Dreamweaver  

• แถบคาํเครือ่งมอื (Toolbar) รวบรวมปมุคาํสัง่ทีใ่ชง้านบอ่ย่   

ส่วนประกอบต่างๆ ของหน้าจอ Dream

 
แสดงสว่นประกอบของ Dreamweaver 

 
หน้าจอแสดงผล (Document Windows)  

หน้าต่างการทาํงานของ Dreamweaver สามารถเลอืกหน้าต่างการทาํงานได ้3 รปูแบบ โดยการคล
ไอคอนทีอ่ยูใ่นแถบเครือ่งมอื Toolbar ดงัน้ี  

กิ

Show Code View เป็นหน้าต่างทีใ่หแ้สดงเฉพาะโคด้ HTML ของหน้าเวบ็เพจที ่กาํลงัทาํงาน  
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Show Code and Design View เป็นหน้าต่างทีแ่สดงทัง้โคด้ HTML และหน้าเวบ็เพจทีก่าํลงัทาํงาน  

Show Design View ใหแ้สดงแต่หน้าเวบ็เพจไมต่อ้งแสดงโคด้ HTML  
 

 

การเรมกาํหนดโครงรางของเวบ็ิ่ ่   

ก่อนดาํเนินการสรา้งเวบ็เพจ ขัน้แรกควรกาํหนดใหข้อ้มลูต่างๆ ทีเ่กีย่วขอ้งอยูใ่น Folder เดยีวกนั เพือ่
งา่ยต่อคน้หาและจดัเกบ็ ตวัอยา่งเชน่ทาํเวบ็เพจของหน่วยงานก่อนอืน่เราควรสรา้ง Folder ชือ่ของหน่วยงาน
ก่อนอาจเป็นภาษาองักฤษหรอืภาษาไทยกไ็ด ้แลว้ใน Folder หน่วยงานคอ่ยสรา้ง Folder ยอ่ยอกีท ีอาจ
ประกอบดว้ยหลาย Folder ยอ่ย เพือ่ใชส้าํหรบัแยกเกบ็ไฟลต่์าง ๆ เป็นหมวดหมู ่เชน่ ไฟลร์ปูภาพ ไฟล ์HTML 
และ ไฟล ์Multimedia ต่างๆ  
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เร่ิมต้นสร้างเวบ็ไซต ์ 

หลงัจากทีส่รา้ง Folder เพือ่ใชเ้กบ็ขอ้มลูแลว้ ขัน้ต่อไปคอืการสรา้งเวบ็ไซต ์โดยการกาํหนด Site 
Manager ใหก้บัเอกสาร โดยมหีลกัการสรา้งดงัน้ี  

1. เลอืก เมนู Site > เลอืกคาํสัง่ New Site  
2. เลอืกแทบ็ Advanced  

 

 

 
 

การตัง้คาเพ่ือให้อานภาษาไทยได้่ ่   

หลงัจากทีท่าํการตดิตัง้โปรแกรม Dreamweaver แลว้ โปรแกรมจะไมรู่จ้กั Font ภาษาไทย เน่ืองจาก 
Dreamweaver ไมส่นบัสนุนภาษาไทย ดงันัน้เราตอ้งตดิ  Font ภาษาไทยก่อน ซึง่สามารถ Download ไดท้ี ่
http://www.thaiware.com/softwae/develop/DV00250.htm ซึง่เป็นโปรแกรมทีถู่กพฒันาจากคนไทย เมือ่ 

Download ไดแ้ลว้ใหท้าํการตดิตัง้เพิม่เตมิ เพือ่ใหโ้ปรแกรมสามารถอ่านภาษาไทยได ้ 
หลงัจากตดิตัง้ Font ภาษาไทยลงเครือ่งแลว้ เมือ่เปิดโปรแกรม Dreamweaver มาใชง้านใหเ้ลอืกคาํสัง่

ดงัน้ี เพือ่ตัง้ Font ใหมใ่หเ้อกสาร  
1. เลอืกเมนู Edit > เลอืกคาํสัง่ Preferences  
2. เลอืก Fonts > Font Setting > เลอืก Thai 
 

ตัง้
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การเพมิ่  Font เพ่ือใช้งาน  

เราสามารถเพิม่ Font เพือ่ใชง้านได ้โดยการนํา Font จาก Windows มาใชง้าน Dreamweaver 
โดยเลอืกคาํสัง่ดงัน้ี  

1. Text > Font > Edit Font List  
2. เลอืก Font เชน่ Microsoft Sans Serif 
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การกาํหนดรายละเอียดของหน้าเวบ็เพจ  

ก่อนเริม่กาํหนดรายละเอยีดต่างๆ ใหห้น้าเวบ็ เราควรเริม่โดยการกาํหนดรายละเอยีดของหน้าเวบ็ก่อน 
โดยมขีัน้ตอนดงัน้ี  

1. เลอืกเมนู Modify > Page Properties 
2. ปรบัเปลีย่นขอ้มลู 

 
 

 
 

การสร้าง

มาะสาํหรบัการนําเสนอขอ้มลูจาํนวนมาก เพือ่ความสะดวกในการจดัการขอ้มลูและ
ความเป็น ง

จ ก่อนอื่นเรามาทาํความรูจ้กักบัสว่นประกอบของตารางก่อน 

 Table  

การใชต้ารางเห
สดัสว่น ควรจดัระบบการนําเสนอขอ้มลูของหน้าเวบ็เพจโดยการใชต้ารางเป็นตวัจดัการในการจดัวา

ขอ้มลูในแต่ละหน้าเวบ็เพ
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การกาํหนดขนาดของเซลล ์ 

1. ให ้Click เลอืกเซลลท์ีต่อ้งการ หรอื Click ทีแ่ทก็ <td> ทีม่มุซา้ยของหน้าจอกไ็ด ้(ใชไ้ดใ้นกรณทีี่
เลอืกตารางไวก้่อนแลว้) ให ้Click ที ่Properties เพือ่กาํหนดขนาดของเซลล ์ดงัรปู  

 
การเลือกเซลล ์และ การกาํหนดสีพืน้  

1. ให ้Click เลอืกเซลลท์ีต่อ้งการ หรอื Click ทีแ่ทก็ <td> ทีม่มุซา้ยของหน้าจอกไ็ด ้(ใชไ้ดใ้นกรณทีี่
เลอืกตารางไวก้่อนแลว้)  

2. ให ้Click ที ่Properties เพือ่กาํหนดส ีโดยเลอืกที ่BG แลว้กาํหนดเลอืกส ี(ใหเ้ลอืกสเีขยีว) หรอื
สามารถพมิพร์หสัสไีด ้ 
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กระทรวงเทคโนโลยสีารสนเทศและการสือ่สาร   64 

 

http://www.mict4u.net 

โครงการอบรมเพ่ือการสงเสริมและพฒันาการใช ้่ ICT  
ณ ศนูยก์ารเรียนรู้ ICT ชุมชน 

 
การแทรกแถวและคอลมัน์  
การแทรกแถว  

1. นําเคอรเ์ซอรไ์ปวางยงัตาํแหน่งทีต่อ้งการจะแทรกแถว  
2. Click Mouse ปมุขวาจะปรากฎเมนูยอ่ย่  ใหเ้ลอืก Table > Insert Rows or Columns..  
3. จะม ีDialog Box ใหก้าํหนดรปูแบบของการแทรกตารางวา่ จะเลอืกแทรก Rows หรอื Column  
(ใหแ้ทรก Rows จาํนวน 2 Rows)  
4. กาํหนดการแทรก Rows ใหแ้ทรกกอ่น (Above the Selection) หรอืหลงั (Before the Selection) ได ้
5. ในกรณทีีต่อ้งแทรก Column จะมใีหแ้ทกก่อน (Before current Column) หรอืหลงั (After current Column) 
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แสดงขัน้ตอนการแทรกแถวและคอลมัน์ 

 
 

 
 

แสดงกา s จาํนวน 2 Rows หนา้จอท่ีไดแ้สดงดงัรูป 
 

รแทรก Column หลงัจากแทรก Row
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การพมพข้์อความและการกาํหนดตวัอกัษริ   

การพมิพข์อ้ความในเวบ็เพจจะคลา้ยกบัการพมิพเ์อกสารใน Word โดยเราสามารถจดัรปูแบบขอ้ความ
ใหส้วยงามไดด้ว้ย โดยอาจใชต้วัอกัษรกราฟิกทีส่ตีวัอกัษรตดักบัสพีืน้ฉากหลงั เพือ่ใหส้ามารถอ่านไดง้า่ย และเรา

ละขนาดตวัอกัษรไดโ้ดยใหเ้ลอืกขอ้ความทีต่อ้งการปรบัแต่ง และแกไ้ขคา่ต่าง ๆ ไดท้ี่
ะเอยีดดงัน้ี  

ีเ่รานํามากาํหนดใหก้บัขอ้ความได ้ 
แบบตวัอกัษร โดยใน Dreamweaver จะแสดงรปูแบบตวัอกัษรทีม่ใีนเครือ่ง PCและเครือ่ง MAC  

• S นทีก่าํหนดไวค้อื 3  
• C

สามารถจดัรปูแบบแ
หน้าต่าง Properties โดยมรีายล

• Format เป็นรปูแบบตวัอกัษรสาํเรจ็ท
• Font รปู

ize ขนาดของตวัอกัษร ขนาดมาตรฐา
olor กาํหนดสใีหต้วัอกัษร 

 
 

การเช่ือมโยง (Link)  

การเชือ่มโยงบนเวบ็เพจมดีว้ยกนัหลายรปูแบบ อาจแบง่ตามการใชง้าน หรอืตามลกัษณะของการ
เชือ่มโยงภายในเวบ็เพจ และการเชือ่มโยงภายนอกเวบ็เพจ แต่ถา้แบง่ตามวตัถุประสงคข์องรปูแบบการใชง้านจะ
แบง่การเชือ่มโยงเวบ็เพจ  
ออกเป็นดงัน้ี  

การเชือ่มโยงภายในเวบ็เพจเดยีวกนั  
การเชือ่มโยงภายในไซต์เดียวกนั  

การเช่ือมโยงไปยงัเว็บไซต์อ่ืน  

 

1. การเชือ่มโยงดวัย e-Mail  
2. การเชือ่มโยงไปยงัไฟล ์Download  
3. การเชือ่มโยงดว้ย Map Link 

1. ทาํแถบสคีลุมขอ้ความทีใ่ชเ้ป็นจุดลงิค ์ 

 
การทาํลงคเ์ช่ือมไฟล์ิ   

การทาํลงิคเ์ชือ่มไฟล ์สามารถทาํไดห้ลายฟอรแ์มต ทัง้ไฟลส์กุล HTML และอื่นๆ โดยไฟลอ์ื่นๆ จะ
ทาํงานในลกัษณะ Download ไฟล ์ 

2. สงัเกตทีแ่ถบ Properties จะเหน็รายการ Link  
.. พมิพช์ือ่ไฟลท์ีต่อ้งการใหล้งิค ์ 
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ชือ่ไฟลอ์าจจะเป็นไฟล ์.html หรอื ไฟลใ์ดๆ กไ็ด ้โดยจะตอ้งระบุ "นามสกุล" ของไฟลด์ว้ยเสมอ (หมาย
เหตุ ระวงัเรือ่งพมิพช์ือ่ไฟลต์วัพมิพใ์หญ่ ตวัพมิพเ์ลก็ ถอืวา่เป็นคนละตวักนั) สามารถใชป้มุสญัลกัษณ์รปูแฟมสี่ ้

ลอืง เลอืกไฟลไ์ด ้เมือ่กาํหนดชือ่ไฟลท์ีต่อ้งการลงิคจ์ากรายการ Link เรยีบรอ้ยแลว้ ใหนํ้าเมาสม์าคลกิในพืน้ที่
ทาํงาน เพือ่ยนืยนัการกาํหนดลงิค ์ 
การยกเลกลงค์ิ ิ   
1. ใหค้ลกิเมาส ์ณ จุดลงิคเ์ดมิ  
2. ลบรายชือ่ไฟลอ์อกจากรายการ Link  
การทาํลงค์ิ   

1. ทาํแถบสคีลุมขอ้ความทีต่อ้งการ  
2. สงัเกตทีแ่ถบ Properties จะเหน็รายการ Link  
3. พมิพค์าํบงัคบัในการทาํจุดลงิคเ์พือ่สง่เมลค์อื mailto: แลว้ตามดว้ย E-Mail Address ของผูจ้ดัทาํ
เอกสารเวบ็ (หมายเหตุ ระวงัเรือ่งพมิพช์ือ่ไฟลต์วัพมิพใ์หญ่ ตวัพมิพเ์ลก็ ถอืวา่เป็นคนละตวักนั และให้
พมิพต์ดิกนัทัง้หมด) ตวัอยา่ง  
ต งการทาํลงิคเ์พือ่ใหส้ง่เมลไ์ปยงั http://ictcenter.spu.ac.thใหร้ะบุคา่ดงันี 
 

เห

อ้

 
 

 
 

รปูแสดงการเชือ่มโยงกบั e-Mail 

ก ลงคเ์รียกเวบ็ไซตอ่ื์นิ   
ุดว้ยคาํบงัคบั คอื http://ช่ือเวบ็ ทัง้น้ีสามารถระบุ 

Ta
 

ก

1.
.  as Template แลว้ click ปมุ่ Save  

 

ารทาํจดุ
ใชห้ลกัการเดยีวกบัการทาํลงิคเ์ชือ่มไฟล ์แต่ใหร้ะบ

rget =_blank เพือ่เปิดหน้าต่างใหมใ่นการแสดงผล 

ารสร้างเทมเพลตจากหน้าเวบ็ท่ีออกแบบไว้แล้ว  

 เลอืกคาํสัง่ File > Save as Template เพือ่ save file หน้าเวบ็เพจทีเ่ราไดอ้อกแบบไวเ้ป็นไฟลเ์ทมเพลต  
 ตัง้ชือ่ไฟลเ์ทมเพลตในหน้าต่าง Save2
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3. เมือ่เปิดดหูน้าต่าง Template (เปิดหน้าต่างน้ีไดโ้ดยเลอืก Windows > Template) จะแสดงไฟลเ์ทมเพลตทีเ่รา
สรา้งเกดิขึน้ 
 

 
 

 
 

  
 

 

เมือ่เปิดดหูน้าต่าง Template (เปิ
เกดิขึน้ 

รปูแสดงการเกบ็ข

ดหน้าต่างน้ีไดโ้ดยเลอืก Windows >Template) จะแสดงไฟลเ์ทมเพลตทีเ่ราสรา้ง

การกาํหนดพืน้ท่ีท่ีเปล่ียนแปลงได้ในเทมเพลต  

1. เปิดหน้าเทมเพลตเลอืกเมนู Insert > Template Object > Edit Region  
2. กาํหนดชือ่เรยีกพืน้ทีท่ีส่ามารถเปลีย่นแปลงได ้แลว้ click mouse ปมุ่ ok  
3. ชือ่ทีต่ ัง้จะปรากฎในบรเิวณทีส่ามารถเปลีย่นแปลงได ้ซึง่ในขณะทีเ่ราเปิดเทมเพลตเราจะแกไ้ขไดท้ัง้พืน้ทีท่ีก่าํหนดให้
เปลีย่นแปลงได ้และพืน้ทีล่อ็คไว ้แต่เมือ่ใดทีเ่รานําเทมเพลตน้ีไปใชก้บัหน้าเวบ็เพจ หน้าเวบ็เพจนัน้จะแกไ้ดเ้ฉพาะพืน้ทีท่ีถู่ก
กาํหนดไวใ้หเ้ปลีย่นแปลงไดเ้ทา่นัน้  

 

ve file หน้า
เวบ็เพจทีเ่ราไดอ้อกแบบไว้
เป็นไฟลเ์ทมเพลต  

อ้มลูข

ตัง้ชือ่ไฟลเ์ทมเพลตใน
หน้าต่าง Save as 
Template แลว้ click ปมุ่ 
Save  

เลอืกคาํสัง่ File > Save as 
Template เพือ่ sa

องเทมเพลต  
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รปูการเปลีย่นแปลงขอ้มลูเทมเพลต 

  
 

 
 

 
 

 

เปิดหน้าเทมเพลตเลอืกเมนู 
Insert > Template Object > 

ชือ่ทีต่ ัง้จะปรากฎในบรเิวณที่
สามารถเปลีย่นแปลงได ้ซึง่ในขณะ
ทีเ่ราเปิดเทมเพลตเราจะแกไ้ขได้
ทัง้พืน้ทีท่ีก่าํหนดใหเ้ปลีย่นแปลง
ได ้และพืน้ทีล่อ็คไว ้แต่เมือ่ใดทีเ่รา
นําเทมเพลตนี  

กาํหนดชือ่เรยีกพืน้ทีท่ีส่ามารถ
เปลีย่นแปลงได ้แลว้ click 
mouse ปมุ่ ok  

ไปใชก้บัหน้าเวบ็เพจ หน้าเวบ็
เพจนัน้จะแกไ้ดเ้ฉพาะพืน้ทีท่ี่
ถูกกาํหนดไวใ้หเ้ปลีย่นแปลงได้
เทา่นัน้  

Edit Region  
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การนําเทมเพลตมาใช้งาน  

1. เปิดหน้าเวบ็เพจเปลา่ขึน้มา  
2. เลอืกแทบ็ Template  

เลอืกชือ่เทมเพลตทีต่อ้งการ และ click mouse ปมุ่ Select เน้ือหาทีม่ใีนเทมเพลตจะถูกนํามาเพิม่เขา้
ไปในหน้าเวบ็ใหม ่ในสว่นทีเ่ป็นเทมเพลตเราไมส่ามารถเขา้ไปแกไ้ขได ้แต่เราสามารถออกแบบหน้าเวบ็เพจใน
สว่นทีแ่กไ้ขไดเ้ทา่นัน้  

 
 

 
รปูการเลอืกเทมเพลตทีจ่ะนํามาใชง้าน  
 

รปูการนําเทมเพลตมาใชง้าน  
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รูปแสดงหนา้จอเม่ือเปิดเทมเพลตมาใชง้าน 
เลอืกชือ่เทมเพลตทีต่อ้งการ และ click mouse ปมุ่ Select เน้ือหาทีม่ใีนเทมเพลตจะถูกนํามาเพิม่เขา้

ไปในหน้าเวบ็ใหม ่ในสว่นทีเ่ป็นเทมเพลตเราไมส่ามารถเขา้ไปแกไ้ขได ้แต่เราสามารถออกแบบหน้าเวบ็เพจใน
สว่นทีแ่กไ้ขไดเ้ทา่นัน้  

 

ารปรบัปร

เมือ่ใดทีเ่ราทาํการแกไ้ขเทมเพลต Dreamweaver จะถามวา่เราตอ้งการใหก้ารเปลีย่นแปลงน้ีมผีลกบั
หน้าเวบ็เพจอืน่ทีใ่ชเ้ทมเพลตน้ีดว้ยหรอืไม ่ 

1. เปิดเทมเพลตทีส่รา้งไวแ้ลว้ขึน้มาทีจ่ะปรบัปรุง  
2. ทาํการแกไ้ขเทมเพลตตามความตอ้งการ เสรจ็แลว้ทาํการ Save  
3. Click Mouse ปุม่ Yes เพือ่ปรบัปรุงหน้าเวบ็เพจทีใ่ชเ้ทมเพลตน้ีทัง้หมดตามการเปลีย่นแปลงที่

เกดิขึน้ โดยในชอ่ง Lock in ใหเ้ราระบุเพิม่เตมิวา่จะกําหนดใหป้รบัปรุงไฟลท์ีใ่ชเ้ทมเพลตในเวบ็ไซตท์ีเ่ราเลอืก 
หรอืใหป้รบัปรงุทุกไฟลท์ีใ่ชเ้ทมเพลตในเวบ็ไซตท์ีเ่รากาํลงัเปิดอยูน้ี่กไ็ด ้ 

4. จากนัน้จะมรีายงานผลการ Update ไฟล ์Click Mouse ปมุ่ Close เพือ่ปิดหน้าต่างน้ี  
หากในการแกไ้ขเทมเพลตเราไมไ่ดก้าํหนดใหก้ารเปลีย่นแปลงน้ีมผีลกบัหน้าเวบ็เพจอื่น แต่ ต่อมา

ภายหลงัตอ้งการใหม้ผีล กท็าํไดโ้ดยเลอืกคาํสัง่ Modify > Templates > Update Pages 
 

ก งุแก้ไขเทมเพลต  
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รูปการ Save เทมเพลตเม่ือมีการปรับปรุงแกไข้  
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